Contents

1. Preface.................................................................................................................................................. 5
   1.1 What is Curve Pilot.......................................................................................................................... 5
   1.2 Installation.......................................................................................................................................... 5
   1.3 Data Types......................................................................................................................................... 5
   1.4 How to Read this Guide.................................................................................................................... 6
       1.4.1 Conventions................................................................................................................................. 7

2. What is Dot Gain?................................................................................................................................... 8
   2.1 Sources of Dot Gain.......................................................................................................................... 10

3. Dot Gain Compensation......................................................................................................................... 12
   3.1 Dot Gain Compensation Curves....................................................................................................... 12
   3.2 How Much Dot Gain Compensation to Apply................................................................................ 14

4. Press Fingerprinting............................................................................................................................ 16
   4.1 What is Press Fingerprinting.......................................................................................................... 16
   4.2 How to Fingerprint a Press............................................................................................................. 16
   4.3 Press Fingerprinting with Curve Pilot.......................................................................................... 17

5. Working with DGC Curves.................................................................................................................... 18
   5.1 The Curve Pilot Editor..................................................................................................................... 18
       5.1.1 Create a DGC Curve.................................................................................................................... 18
       5.1.2 Save a DGC Curve...................................................................................................................... 19
       5.1.3 Import Measured Points from Text File..................................................................................... 19
       5.1.4 Preview a DGC Curve................................................................................................................ 20
       5.1.5 Edit Measured & Calculated Data............................................................................................... 21
       5.1.6 Select a Desired Dot Gain Curve............................................................................................... 21
       5.1.7 Create a Desired Dot Gain Curve............................................................................................... 22
       5.1.8 Edit a Desired Dot Gain Curve.................................................................................................. 22
       5.1.9 Swap Measured Points.............................................................................................................. 23
       5.2 Advanced Curve Editing............................................................................................................. 24
           5.2.1 Import Tone Curve Exchange Data (ISO 18620)................................................................. 24
           5.2.2 Smooth Curve......................................................................................................................... 25
           5.2.3 Minimum and Maximum Values............................................................................................ 25
           5.2.4 Keep 0% to: Parameter.......................................................................................................... 26
           5.2.5 Keep 100% Parameter............................................................................................................ 27
           5.2.6 Bump Highlights.................................................................................................................... 28
           5.2.7 Fit PressSync Curve............................................................................................................... 29

6. Working with PressSync....................................................................................................................... 31
   6.1 PressSync Curve Sets....................................................................................................................... 31
7. Working with DGC Strategies................................................................. 61
  7.1 What is a Strategy?.............................................................................. 61
    7.1.1 Simple Ink-Based Strategies....................................................... 61
    7.1.2 Combined Ink- and Screen-Based Strategies.............................. 61
  7.2 Creating a Strategy............................................................................ 62
  7.3 DGC Strategies and PressSync Curve Sets....................................... 64
  7.4 How the RIP Retrieves the Right DGC Curve................................. 65

8. The Preview Combined Curves Tool.................................................... 67
  8.1 Previewing a Combination of Curves................................................ 67
  8.2 Previewing the Results of a Strategy................................................. 69
  8.3 Previewing the Stochastic Range of SambaFlex Screens.................... 70

9. Archiving DGC Data........................................................................... 71

10. Appendices....................................................................................... 72
    10.1 Location of Data Files................................................................. 72
    10.2 Dot Gain Metrics........................................................................ 72
1. Preface

1.1 What is Curve Pilot

Curve Pilot is a software tool that calculates Dot Gain Compensation (DGC) curves from measured data. Curve Pilot helps you correct the dot gain characteristics of your system towards desired printing targets through the adaptation of intensities used during the film- and plate-making process.

Curve Pilot provides:

- A **DGC Curve Editor** for calculating single dot gain compensation curves from measured data and (optionally) desired / reference dot gain targets.

- **PressSync** for calculating sets of ink-based dot gain compensation curves (**PressSync Curve Sets**) from measured data and a variety of printing conditions based on industrial specifications or ISO standards.

- A **DGC Strategy Editor** for combining single dgc curves and PressSync curve sets into complete compensation strategies; using strategies enables you to assign multiple dgc curves to the same ink / separation based on varying screening parameters.

1.2 Installation

To install Curve Pilot on your PC, follow the instructions on the Imagine Engine installation wizard.

If you own a PressSync license, Curve Pilot is installed as two applications:

<table>
<thead>
<tr>
<th>Application Name</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Curve Pilot</td>
<td><img src="image" alt="Icon" /></td>
<td>All Basic and/or PRO functionality + PressSync functionality</td>
</tr>
<tr>
<td>PressSync Pilot</td>
<td><img src="image" alt="Icon" /></td>
<td>PressSync functionality only</td>
</tr>
</tbody>
</table>

**Note:** You do not need to run PressSync Pilot separately. With a PressSync license, you can access all PressSync functionality from within the Curve Pilot user interface.

1.3 Data Types

Curve Pilot works with the following types of data files:
1.4 How to Read this Guide

This guide assumes no prior experience in calculating dot gain compensation (dgc) curves or setting up dgc-related workflows.

If you are not familiar with the concepts of dot gain, dot gain compensation, and press fingerprinting, you are encouraged to read the relevant sections on What is Dot Gain? on page 8 and Dot Gain Compensation on page 12, the topics under Press Fingerprinting on page 16, and also the concepts behind What is a Strategy? on page 61 first.

If you are an experienced pre-press or press professional, you can safely skip this introductory material and start at Press Fingerprinting with Curve Pilot on page 17, to learn more about the distinct Curve Pilot and PressSync Pilot features.

If you want to generate dgc curves manually, read Working with DGC Curves on page 18; start with The Curve Pilot Editor on page 18, then move on to Advanced Curve Editing on page 24.

If you are a pre-press manager seeking an integrated process for managing the dgc needs of your print setup based on printing standards or specifications, read Working with PressSync on page 31. PressSync functionality can be studied independently without prior knowledge of using the Curve Pilot dgc curve editor.

PressSync presents a systematic way of calculating ink-based curve sets conforming to a variety of printing standards; to leverage the full potential of PressSync, a better understanding of PressSync Curve Sets on page 31, Automated Measurements on page 38, PressSync Templates Based on the ISO 12647 Standards on page 81, PressSync Templates Based on the G7 Calibration Method on page 83, and possibly Advanced PressSync Topics on page 55 will be required.

To devise combined ink-based and screen-based dgc strategies, read Working with DGC Strategies on page 61.

To understand the effect of applying multiple dgc curves on the same job, study the material on The Preview Combined Curves Tool on page 67.
This guide is complemented with a number of Appendices on page 72 providing mostly reference information on various features of the software. Depending upon your level of knowledge and expertise, you may want to refer to these topics selectively on a need basis.

### 1.4.1 Conventions

A number of typographic conventions are used throughout this guide:

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Dot gain</strong></td>
<td>Terms introduced for the first time, terminology, important keywords may be displayed in bold for emphasis</td>
</tr>
<tr>
<td><strong>Save As...</strong></td>
<td>Menu items, window / dialog titles, user-interface elements are always displayed in bold</td>
</tr>
<tr>
<td><strong>User Defined</strong></td>
<td>User input including selections in list boxes is displayed in a monospace (typewriter) font</td>
</tr>
<tr>
<td>[0..100]</td>
<td>Numerical ranges are enclosed in brackets []</td>
</tr>
<tr>
<td>&lt;InkName&gt;</td>
<td>Variable content is enclosed in angle brackets &lt;&gt;</td>
</tr>
<tr>
<td>&quot;C</td>
<td>M</td>
</tr>
<tr>
<td>\server\bg_data_dgc_v010\</td>
<td>Application folders and directory paths are always displayed in a monospace (typewriter) font</td>
</tr>
</tbody>
</table>
2. What is Dot Gain?

Most printing processes convert high-level vector digital information (such as a PDF or PS file) into high-resolution raster or bitmap images, also known as digital films, one for each printing ink. A Raster Image Processing (RIP) application creates digital films with a resolution (expressed in ppi) that is supported by the imaging device.

For every printing ink, the RIP application puts a raster of pixels at the resolution of the imaging device on top of the original design. To take into account the intensity of the object, the screening raster is added. For every pixel of the object that is lying in a dot of the screen, the pixel is set to black in the final digital film (for a positive film).

The distance between the dots in this screening raster is expressed in lpi (lines per inch), lpcm (lines per cm) or lpm (lines per mm). This is called the screen ruling.
After the ripping phase, films and/or plates are created and put on the press. The file is printed and... is (much) darker than the original file in the desktop program.

The reason for this will be no surprise to most people: dots on the press always print **fatter** than the original dots on the film or plate, they increase in size. This phenomenon is known as **Dot Gain**.

Take a look at an example design:

<table>
<thead>
<tr>
<th>Original image</th>
<th>Printed result</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Original Image" /></td>
<td><img src="image2.png" alt="Printed Result" /></td>
</tr>
</tbody>
</table>

Take a closer look and observe the differences in between the design, the digital film, and the final print result:
On microscopic level, dot gain would look like this:

2.1 Sources of Dot Gain

The amount and type of dot gain are influenced by different factors. Especially the type of press (offset, flexo, gravure...), the type of substrate (coated paper, uncoated paper....) and the type of ink have a large influence on the dot gain.

Four different sources of manufacturing dot gain can be distinguished:

1. Plate making dot gain

In the case of an offset process, the image on the film is transferred photographically to the plate. This is typically done by exposing a pre-sensitized plate, masked by the film, to intense UV-light. For several reasons, the image is always slightly overexposed. This causes a 50 percent screen dot to result in a 45% dot on the plate, if a positive masking film is used, and a 55% dot if a negative film is used.

In the case of a flexo-process, exposing the negative film in the copy frame also results in dots on the plate that are significantly bigger than the white dots on the negative film, sometimes even 10%.

In case of direct-to-plate imaging, there is no copy phase from film to plate. As a result, plate-making dot gain or dot loss is completely avoided. Possible fluctuations in dot gain
during plate-making are avoided as well. This is one of the main advantages of direct-to-plate technology. However, plate-making through a direct-to-plate process has a different dot gain behavior than plate-making for which a frame copy from film is used.

Plate making dot gain is difficult to control because several factors are involved: longer or shorter exposure times, the nature of the light source, the film and the plate.

2. Printing-pressure of the ink

On the press, due to the pressure (flexo!) and to the fact that the ink is fluid, a 50 % dot on the plate will cover a paper area equivalent to a 60 % dot.

3. Paper type

The surface roughness and porosity of the paper cause internal light reflections around the ink boundaries, making the border areas look darker. On smooth coated paper, a 50 % covered area will perhaps only reflect 40 % of the incident light, resulting in an apparent 60 % dot. On uncoated paper it would look even darker.

4. Type of press

There are different printing methods (flexo, offset, gravure...), so it is logical that there are also a lot of variations in the dot gain.

a. Offset Printing

For a typical offset press, with a positive film to plate, and a 50% dot on film:

- The plate-making will lose 5%
- The press will add 10% (dependent on the pressure)
- Coated paper reflections will add another 12%

Which will give a final result of 67%, or 17% apparent dot gain.

b. Flexographic Printing

We have already explained that the printing pressure of the ink has a huge influence on the amount of dot gain: the more pressure, the more dot gain. That is why, generally, flexo presses have higher dot gain values, for example:

<table>
<thead>
<tr>
<th>Film</th>
<th>Print</th>
</tr>
</thead>
<tbody>
<tr>
<td>40%</td>
<td>78%</td>
</tr>
<tr>
<td>80%</td>
<td>98%</td>
</tr>
</tbody>
</table>

c. Gravure Printing

Gravure presses are characterized by a type of dot gain that is similar to that of offset presses for small dot sizes (up to circa 30%), but sharply increasing at higher percentages. Solid areas are printed with an effective cylinder dot area of 60 to 70%.
3. Dot Gain Compensation

For many print buyers dot gain has an unexpected and above all unwanted quality effect on the prints:

- Because of the increase in the printed dot, the general aspect will be too dark.
- Dot gain in screened densities also causes huge changes in hue and saturation.

Another example: a color made up of 100% cyan and 50% magenta will suffer from dot gain in the magenta, but not in the cyan. The color will be too dark but also too red.

Print buyers want predictable and correct printed results that are up to a standard or correspond to the contract proof. That is why Dot Gain Compensation (DGC) is definitely needed.

The basic principle of dot gain compensation is very simple. Take a look at the following picture:

This picture explains that, in order to obtain a dot of the right size in print, a smaller dot has to be put on the digital film. In other words, applying dot gain compensation means that the original dot is compensated (usually reduced) to a certain extent on the digital film.

3.1 Dot Gain Compensation Curves

We can compute dot gain curves by relating tone values (intensities) in the input to tone values in the output. In the sample dot gain curve below, we can see that a tone value of 20% in the input (digital film) measures 57% in the output (printed result), while a tone value of 50% in the input measures 85% in the output.
If we want to print linearly, i.e. eliminate all dot gain in the output, then we need to apply a dot gain compensation curve that is the “mirror image” of the dot gain curve for our process. This curve is shown below next to the dot gain curve for contrast.

We can easily tell that data points on the dot gain compensation curve have been inverted: a tone value of 57% in the input becomes 20% in the output, while a tone value of 85% in the input becomes 50% in the output.

The combined effect of both curves on our print job is full dot gain compensation (linearization). This is clearly shown in the third graph (green line) below.
This is the principle applied during ripping and printing. Prior to screening, all intensity values are pulled down by the dot gain compensation curve (blue), leading to smaller dots on the digital film. The press "adds" its usual dot gain (red), resulting in intensity values that correspond to the original design.

3.2 How Much Dot Gain Compensation to Apply

Let us take another look at our example design, and compare the printed results with no dot gain compensation and full dot gain compensation (linearization) below.

However, eliminating all dot gain from a print job is not always desirable. This is explained further in How Much Dot Gain Compensation to Apply on page 14.
Printed result with no dot gain compensation

Printed result with full dot gain compensation (linearized)

Take a good look at the picture above, and ask yourself the following question: "Am I happy with this result?" The answer will probably be "No", because the printed result is too light. The human eye is used to expect a certain amount of dot gain in printouts, and the amount of dot gain present in print jobs has historically grown. The standard offset dot gain (50% prints as 68.5%) has always been considered visually acceptable.

Full dot gain compensation (in other words, linearization) clearly produces prints that are too light. In order to obtain a visually pleasing print result, a certain amount of dot gain must be retained in the final printout. This amount is specified in a target. The target defines a desired, or reference, printing condition.

**Matching a target** involves tuning / syncing the printing process so that the amount of dot gain present in the final print follows the amount of dot gain specified in the target within acceptable margins. Very often standard offset dot gain is used as the target (or reference condition) to match.
4. Press Fingerprinting

4.1 What is Press Fingerprinting

The process to determine how a press prints and to quantify dot gain values is commonly known as press fingerprinting. Following a fingerprint run, a dot gain compensation (dgc) curve or curve set (for different inks) is created, so that the printed tone values can match a standard.

Fingerprinting is an essential validation step of the prepress and press settings. Without fingerprinting, the task of printing to a desired printing condition or standard becomes increasingly difficult.

Fingerprinting does not replace, and should not be confused with, routine preventative maintenance. In fact, a press should be in top operating condition prior to the fingerprinting process, so that fingerprinting results (measured densities, dgc curves, etc.) can be reproducible and reliable.

Production jobs may contain control strips that are measured manually or automatically to check print consistency. If the control strips are consistently measuring the same but not within the desired print condition or standard tolerance, the dgc curve(set) for the press will have to be adjusted.

Press fingerprinting depends on most operating parameters and will have to be repeated if there is a change to these parameters, including substrate type, ink, plate, run speed, screening (dot shapes, ruling, screen angles), and even operator experience / skill level. In general, there should be a dgc curve(set) for each set of operating parameters commonly employed with a specific press.

4.2 How to Fingerprint a Press

To fingerprint your press for a given set of operating conditions and match its performance to a desired printing condition or standard, you generally have to:

1. Create test jobs that contain patches with different tones, e.g.: 1%, 2%, 3%, 4%, 5%, 10%, 20% ... 80%, 90%, 95%, 100%. The picture below shows a typical control strip of cmy-generated gray tones and cmy-solid.

2. Rip the test job(s) using the procedures outlined in your Imaging Engine or equivalent RIP application manual.
3. If applicable to your printing application, expose the film/plate. Make sure that the normal workflow is applied and that the image-setter is calibrated correctly: 50% in the job must measure 50% on the film, or the black mask in case of a CDI®. Small deviations (up to 1%) are acceptable.

4. Print the test job(s) using a well-defined set of operating conditions (substrate, inks, press speed, screening parameters, etc.)

5. Measure the printed patches.

6. Compare the dot gain present in the print(s) with the reference dot gain set in your desired printing conditions or standards.

7. Adjust the dot gain compensation curves used in your print job(s) if necessary.

4.3 Press Fingerprinting with Curve Pilot

With Curve Pilot, you can fingerprint your press in two distinct ways: (a) using the Curve Pilot dot gain compensation editor for single dot gain compensation (dgc) curves, or, (b) using PressSync functionality to calculate ink-based curve sets from desired printing conditions and/or standards.

If you wish to create dgc curves one by one manually, you can use the Curve Pilot dgc curve editor. You will have to measure control strips from production runs manually, and import your measured data into the application as text files or type them in manually. For each dgc curve to calculate, you will have to select the desired printing target (reference dot gain curve) manually. You will be able to combine individual dgc curves into strategies, but you will have to calculate and save each dgc curve separately before you can generate a strategy.

With PressSync, your workflow will be significantly simplified. You will be able to create and save a dot gain compensation curve set for all process/spot inks present in your job at once. You will typically select a template for your curve set first, based on a number of desired printing conditions extracted from printing specifications or industrial printing standards. You will then measure sample jobs either manually or automatically. Curve Pilot / PressSync Pilot will calculate the best fitting dot gain curve set for matching your preferred standard(s) automatically.

You can also combine using PressSync with the Curve Pilot editor. For example, you can always export a dgc curve from a PressSync curve set into the Curve Pilot editor and refine it further manually.
5. Working with DGC Curves

5.1 The Curve Pilot Editor

The Curve Pilot editor lets you create and modify single dot gain compensation (dgc) curves from measured data and an optional desired (reference) dot gain curve. Advanced curve editing features include the ability to import precalculated dgc curves, and to customize the shape of calculated dgc curves in a variety of ways. For the details, see Advanced Curve Editing on page 24.

5.1.1 Create a DGC Curve

To create a new dot gain compensation (dgc) curve, you need to enter measured data first. Select **New > DGC (.dgc)** from the main **File** menu.
Add your measured data in **New Point**: you can use the **Tab** key to quickly switch from Film% to Print% input data. Hitting **Enter** after you have entered a Print% value takes you back to the Film% input box.

Follow this procedure to enter sample [Film%,Print%] data, e.g. [10%,15%], [30%,40%], [50%,62%], [70%,80%], [90%,95%].

**Note:** If you want to enter density print data instead of % values:

- Select **Edit > Preferences...** on the Curve Pilot main menu and change the DGC **Densitometer measures:** setting from **Percentages** to **Densities**.

- Enter the maximum density of your measurements in the **Maximum Density** input text box. Note that the maximum density in certain flexo applications is not necessarily the density of the solid (100%) patch. Curve Pilot will convert your density values into percentages using the Murray-Davies equation.

### 5.1.2 Save a DGC Curve

When you are done entering measured data, select **File > Save As...** on the Curve Pilot main menu. Enter the desired name for your file without specifying a file extension and click **OK**. A `.dgc` file will be saved under the folder shown on the main window title of your Curve Pilot application. See also **Location of Data Files** on page 72 in the Appendix.

At this point you have not specified a **desired (reference) dot gain curve**. The saved `.dgc` file contains your measurements and a dot gain compensation (dgc) curve calculated from your measured data so that full dot gain compensation (linearization) is achieved in the final print result.

### 5.1.3 Import Measured Points from Text File

As an easier alternative to entering data points into Curve Pilot manually, you can import measured data from a data file.

To import your data, select **File > Import Measured Points from Text File**.

Data points in the file should be in a simple two-column, tab-delimited format as shown below:

<table>
<thead>
<tr>
<th>0</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>15</td>
</tr>
<tr>
<td>20</td>
<td>25</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>70</td>
<td>80</td>
</tr>
<tr>
<td>90</td>
<td>95</td>
</tr>
<tr>
<td>100</td>
<td>100</td>
</tr>
</tbody>
</table>
The data file name can have any extension, but the file itself must be saved as a simple text file.

### 5.1.4 Preview a DGC Curve

Make sure that **Compensation curve** under **Show Curves** is selected. Select **Dot gain curve** as well. You will see two curves on your graph. The red curve is your dot gain curve from the measurements you have entered. The blue curve is your dot gain compensation (dgc) curve. Curve Pilot has calculated the best dgc curve possible to achieve full dot gain compensation (linearization) in your print result.

You can verify this by selecting **Print simulation** under **Show Curves**. The purple line is the expected dot gain curve in your final print result. It is a straight line indicating no dot gain in your print result.
5.1.5 Edit Measured & Calculated Data

You can edit dot gain data points (measured) and dot gain compensation data points (calculated) by dragging them on the curve with the mouse.

To delete a data point, select the point and click Ctrl + D.

Finally, to add a data point, click on the desired location of the graph where you wish to add the new data point.

**Note:** Whenever you edit measurements graphically, the dot gain compensation curve is recalculated to continuously match your *desired dot gain curve* (target).

5.1.6 Select a Desired Dot Gain Curve

You can select a different (non-linear) dot gain curve as your printing reference (target). Make sure that *Desired curve* is enabled, and pick the desired (reference) dot gain curve from the *desired Curve* drop-down list.
The green curve added to the graph is the desired (reference) dot gain curve. Notice how the blue compensation curve has been recalculated automatically. It now adds dot gain to the input (measured) data to match the desired target.

Select **Print simulation** to verify that the estimated dot gain in the final print result (purple curve) closely matches the desired dot gain (green curve). In fact the two curves practically overlap.

Saving your .dgc file saves the measured data, the calculated compensation curve, and the desired (reference) curve all in the same file.

### 5.1.7 Create a Desired Dot Gain Curve

You can create desired curves in addition to the ones provided with your Curve Pilot installation. To do this, simply enter your data and save them under a unique name (i.e. testdgc). Save your data again under a different name (i.e. testdgc-ref), but this time make sure that you select **Save as desired (reference) curve** on the Save DGC dialog. Curve Pilot will create the new reference curve as read-only and will automatically close your editor window after that.

**Note:** You cannot load a desired curve directly from the **File > Open...** menu item of the Curve Pilot main menu.

### 5.1.8 Edit a Desired Dot Gain Curve

Curve Pilot saves all desired (reference) dot gain curves under `{server}\bg_data_dgc_v010\refdgc`, where *server* is the central location of automation data.

You cannot load .dgc files located in the refdgc subfolder directly into Curve Pilot. As a result, you cannot edit desired (reference) curves directly.
To overcome this limitation, copy the desired (reference) curve in the `bg_data_dgc_v010` folder, edit the curve as usual, save it, and move it back in the `refdgc` subfolder.

### 5.1.9 Swap Measured Points

To swap the columns of the measured points, select **Edit > Swap Measured Points** from the Curve Pilot main menu.

This action results in the inverted compensation curve. The inverted compensation curve can be used to "undo" the compensation on pre-compensated images for proofing.

![Measured Points Table and Curve](image)

<table>
<thead>
<tr>
<th>Fm%</th>
<th>Prnt%</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>20</td>
<td>40</td>
</tr>
<tr>
<td>55</td>
<td>70</td>
</tr>
<tr>
<td>100</td>
<td>100</td>
</tr>
</tbody>
</table>

You can add, move or delete points on the Compensation and Dot gain curve.
5.2 Advanced Curve Editing

5.2.1 Import Tone Curve Exchange Data (ISO 18620)

Curve Pilot supports importing Tone curve Exchange Data (ISO 18620) from a file.

To import your data, select **File > Import Tone curve Exchange Data (TED)**. You can only import well-formed files with the extension*.ted*. Importing an improperly formatted *.ted* file may crash the application without warning.

A *.ted* file can contain any number of tone curves. The curve(s) imported from a *.ted* file are always interpreted by Curve Pilot as dot gain compensation curves, not measured data.

Curve Pilot generates an *.icpro strategy* in memory from the imported curves, and saves all *.dgc* files present in the strategy in the *central location of dgc data*. You need to save the *.icpro strategy* separately.
For more information on .ted files and their conversion into .icpro strategies, see Tone Curve Exchange Data (TED) Files on page 80.

5.2.2 Smooth Curve

You can influence the way a dot gain compensation (dgc) curve is calculated by changing the **Smoothing Margin** parameter value. The default value is 3 and the default permissible value range is [0..10].

For more aggressive smoothing, enable **Optimize curve**. The permissible value range becomes [0..20]. A higher value indicates a smoother curve.

![Graph showing smooth curve](image)

5.2.3 Minimum and Maximum Values

Setting the **Minimum Value** and **Maximum Value** parameters refines the shape of a dot gain compensation curve in the highlights and in the shadows respectively. This may be desirable in certain applications of flexography.

With a non-zero Minimum Value, the first non-zero tone / intensity in the job is corrected / compensated at the Minimum Value. The Minimum Value setting does not affect the 0% tone, which remains at 0% and is never screened.

With a Maximum Value smaller than 100, the 100% (solids) tone /intensity in the job is corrected / compensated at the Maximum Value. A Maximum Value setting smaller than 100 implies that the 100% (solids) tone will be screened.

You can examine the effect of these parameters on your dgc / print simulation curves and in the **Compensation Values** Table.
5.2.4 Keep 0% to: Parameter

There may be small intensity values in your job that you can safely discard as digital noise. Equivalently, there may be small dot % values on your uncompensated film/plate that you want to disregard as dust.

You can do this by setting the **Keep 0% to:** parameter to a small value, typically $0.4\%$ or lower. Curve Pilot will treat all input below that value as zero and will set the corresponding corrected / compensated values to zero.
5.2.5 Keep 100% Parameter

The **Keep 100%** setting instructs Curve Pilot to not apply a correction / compensation value for the 100% tone / intensity in the job. This has the result that solids are not screened.

If you disable **Keep 100%**, the 100% (solids) tone will be corrected / compensated to the value set in **Maximum Value**, provided that this is less than 100.
5.2.6 Bump Highlights

You can further modify the shape of the dgc curve in the highlights. To do this:

1. Enable **Optimize curve**
2. Enable **Bump highlights**
3. Enter a value for the **Slope** parameter
4. Enter a value for the **Range** parameter

If you want to influence the shape of the dgc curve over a wider range of input values, select a large value for the **Range** parameter:
To radically change the shape of the dgc curve in the highlights, select a large value for the \textbf{Slope} parameter:

Curve Pilot lets you change the slope (and range) by dragging the slope end point with your mouse.

\textbf{5.2.7 Fit PressSync Curve}

While we have not discussed \textit{PressSync compensation curves} yet, it is worth mentioning at this point that you can fit a PressSync dot gain compensation curve to the dgc curve calculated by Curve Pilot. To do this, enable \textit{PressSync curve} under \textit{Show Curves}. 

\textit{PressSync compensation curves}
The best-fitting PressSync curve is displayed in red next to the PressSync curve check box. The curve is displayed dotted in red.

You can influence the Curve fit by switching between Standard and Robust. For the differences between these two settings, see Curve Fitting Options on page 74.
6. Working with PressSync

6.1 PressSync Curve Sets

6.1.1 What is a PressSync Curve Set?

A PressSync curve set is a collection of predefined dot gain compensation curves, each attached to an ink (a process ink or a spot color defined in Esko’s CMS database).

Curve Pilot / PressSync Pilot creates and saves PressSync curve sets in the .prsync file format. A .prsync file contains information about the desired printing condition, measurement data, the actual dot gain compensation curves, and history data related to curve set setup and/or measurement actions.

When sending a print job to your RIP application, you typically associate one or more .prsync files with it. This way, every separation in your job is compensated with the appropriate PressSync curve. For the details please refer to your RIP application manual.

6.1.2 PressSync Curves

Curve Pilot / PressSync Pilot comes bundled with 400 PressSync curves. Those are predefined dot gain compensation curves of various forms and shapes that can fit the dot gain compensation needs of most presses.

Using PressSync curves significantly reduces the complexity of dot gain compensation in workflows.

PressSync Curve Names

PressSync compensation curves are defined by a letter (A to H) and a number (20 to 70): A40, D20, F30, etc. The letter indicates the general shape of the curve in the highlights and in the shadows. The number indicates the compensation value for the 50% dot (midtone).
PressSync Example Curves

The A50 curve increases dot gain in the highlights (forcing the press to print darker in the highlights), and reduces dot gain in the shadows (thus forcing the press to print lighter in the shadows). The H50 curve exhibits the opposite behavior. Both curves exhibit an inflection point (where their slope changes sign) in the midtone.

The E70 curve increases dot gain throughout the tonal range, correcting the midtone to 70%. The E20 curve decreases dot gain throughout the tonal range, forcing the midtone to 20%.
Minimum and Maximum Values

A PressSync curve can also contain information about a minimum and a maximum value. The minimum value is the correction / compensation for the first non-zero tone. For example, if the minimum is set at 6%, the first non-zero tone value will be adjusted to 6% as shown below.

Note: Regardless of the minimum value you choose, the 0% tone remains at 0%. As a result, the 0% tone will not be screened.

The maximum value is the correction / compensation for the 100% tone (the solids). For example, if the maximum value is 96%, solids will be corrected to 96% and screened as shown below.
6.2 Getting Started with PressSync

The easiest way to generate PressSync curve sets is to make use of predefined PressSync templates available with your Curve Pilot application.

Every predefined PressSync template is linked to a desired printing condition, i.e. a color profile (ICC or Esko) or Fogra characterization data set. The desired printing condition is used to extract desired (target) Lab values for the solids, and desired dot gain curves defined in an international printing standard or industrial specification.

Two distinct types of PressSync templates are currently available:

- Templates prefixed by *cmyk_* contain dot gain targets based on the ISO 12647-2 standard for offset printing. There is a desired (target) dot gain curve for each process color (c,m,y,k).

- Templates prefixed by *3ck_* contain dot gain targets based on the GRACoL specification for commercial offset lithography. There is a desired (target) dot gain curve for cmy-composed gray (3c) and black (k). The exact values are calculated using the G7 calibration method.

You can find detailed information on *cmyk_* templates in *PressSync Templates Based on the ISO 12647 Standards* on page 81, and on *3ck_* templates in *PressSync Templates Based on the G7 Calibration Method* on page 83.

If you have access to a supported spectrophotometer, Curve Pilot can measure test jobs for you automatically. Curve Pilot recognizes a number of standard test printing charts; see supported Print Chart Layouts on page 75.

If you do not have access to a device supported in automated measurements, you can measure your own custom control strips or the supplied universal print target manually.

6.2.1 Creating Your First PressSync Curve Set

To generate a new PressSync curve set from an existing PressSync template using automated measurements:

1. Select **File > New > PressSync CurveSet (.prsync)** from the Curve Pilot top menu.
2. On the **Create New Curve Set** dialog, select a template for your new curve set from the selection list available for **A standard**. If you are not certain which template to use, consult *PressSync Templates Based on the ISO 12647 Standards* on page 81 and *PressSync Templates Based on the G7 Calibration Method* on page 83 first.

![Create New Curve Set dialog](image)

**Note:** Never pick **An empty curve set** if you are planning to perform measurements and calculate PressSync curves afterwards. An empty curve set does not contain any desired printing conditions (targets) and it does not support measurements. It is simply a collection of dot gain compensation curves from the PressSync dgc curve library.

3. Click **Select Curve Names...** on the main PressSync window.

![Select Curve Names dialog](image)

If you have printed your test job without any dot gain compensation, make sure that all dgc curves under **Curve Name** on the **Select Curve Names** dialog are **Linear**.
Otherwise, enter the appropriate PressSync curve(s), including Min and Max values used for printing.

4. Click Measure > Measure Automatic from the main menu.
5. On the Automatic Measurement dialog, select the chart type used in your print job from the Layout selection list.
6. Reconnect your measuring device (if necessary), and click Start. Follow the instructions on the dialog to complete your measurement. You may have to click Start several times.
7. If you want to keep a separate record of measurements only, click Save Measurement... to export your measurement in the .it8 (CGATS) file format and save it in the desired location.
8. You can measure a test job multiple times. Click OK when you are done. Notice that each measurement is listed separately under the Measurements tab.

9. Click on Go To Results to inspect your measurements against the desired (target) dot gain values. A summary of the calculated dot gain compensation curves is included in the rightmost Result panel under the Process Colors tab.
6.3 Measuring with PressSync

To start performing measurements, click **Measure...** on the main PressSync window:

On the **Measure Curve Set** dialog, you have the options to:

1. **Measure a control strip automatically**; select **Automated measurements**. This option is also available from the main menu ( **Measure > Measure Automatic** ).

   Curve Pilot understands a number of industry standard **print chart layouts** and you can even **define your own**. See also **Control Strips for Equinox** on page 77.

2. **Measure the universal target manually**; select **Universal Target**. This option is also available from the main menu ( **Measure > Measure Universal Target** ).

   The **universal target** is a limited type of print chart containing a small number of patches. Measuring the universal target can serve as a starting point for press fingerprinting.

10. Click **Save...** and select **Save curves** to save measured data and calculated PressSync curves, and to set the calculated PressSync curves as the active ones for printing subsequent test jobs. This way you do not need to repeat step (3) above before measuring your next test job.

   If you do not want to save / update the PressSync curves, select **Save measurements only** instead.

11. Select **File > Save As...** from the top menu to save measurements and PressSync curves in a different .prsync file under the **central location of dgc data**.
3. **Measure a control strip of a production sheet manually;** select a **control strip of a production sheet.** This option is also available from the main menu (Measure > Measure Control Strip).

The control strip is also limited in the number of patches and may not be sufficient for a thorough investigation of the dot gain behavior of your system.

4. Resume an incomplete measurement session; select Your last (incomplete) measurement. This option is also available from the main menu (Measure > Continue Incomplete Measurement).

This option will not be available if you have no incomplete measurements pending. You can review your incomplete measurement actions under the History tab of the main PressSync window.

If you have access to a supported spectrophotometer for automated measurements, **Automated measurements** are the preferred measurement method in Curve Pilot.

### 6.3.1 Automated Measurements

To perform automated measurements in Curve Pilot:

1. Click **Measure...** on the main PressSync window.
2. Select **Automated measurements** on the **Measure** dialog.
3. Verify that the PressSync dgc curves listed in the **Used Curves** tab are the ones actually used for printing your test job/chart. If not, enable (check) *The sheet is printed with different PressSync Curves* and enter the correct curve(s) including Min and Max values.
4. Go to the **Measurements** tab.
5. Click **Add Automatic Measurement...**
6. On the **Automatic Measurement** dialog, select the **chart type** used in your print job from the **Layout** selection list.
7. **Reconnect** your measuring device (if necessary), and click **Start.** Follow the instructions on the dialog to complete your measurement; you may have to click **Start** several times.
8. Select a patch on your layout to view detailed information about the patch and the current measurement conditions. See **Measurement Conditions** on page 39 for the details.
9. Optionally, click **Save Measurement...** to export your measurement in the .it8 (CGATS) file format and save it in the desired location.
10. You can measure a test job multiple times. When you are done, click **OK** to return to the **Measurements** tab.

On the **Measurements** tab you can optionally:

1. Add previously measured data; click **Add Measured Data...** and follow the instructions on the dialog to import the measured data set in the .it8 (CGATS) format. This option is also available from the main menu (Measure > Load Measured Data (CGATS)).
2. Add a measured profile; click **Add Measured Profile...** and follow the instructions on the dialog to import the measured profile. This option is also available from the main menu (Measure > Load Measured Profile).
3. **View measurement results** including the calculated compensation curves; click **Go To Results**.
**Note:** Each time you perform a new automatic measurement or add / load measured data or profiles from a file, the **Measured Data** list is updated with the file name of the imported data set.

Measured data from an **Add Automatic Measurement...** action appear under a temporary system folder using a descriptive file name postfixed by `AutoMeas_x.it8`, where `x` is a suitably incremented counter.

You can add any number of measured data sets / profiles to the list. The results (calculated dgc curves) will be based on all measurements averaged.

**Measurement Conditions**

The Automatic Measurement Dialog is organized in two panels: the left panel displays the selected control strip layout; the right panel displays information about the currently selected patch on the strip layout (if any) and about the current measurement conditions.

On the topmost area of the right panel, the cmyk composition of the currently selected patch is displayed. If the patch is a spot color for Equinox, a multi-channel composition (e.g. CMYKOGB) is shown instead.

Desired and measured Lab values for the selected patch, and density / dot gain metrics for the selected patch are shown next. Desired density values are extracted from the desired printing condition (see **Select the Desired Printing Condition** on page 53 for information on setting the desired printing condition for your curve set). Measured density values are extracted from spectral measurements and are postfixed by (R), (G), (B), or (K); the postfix indicates the filter that resulted in the largest density value. It is not always possible to calculate desired density values from a printing condition, because the printing condition may lack spectral data. In this case the density and %DotArea fields will be left blank.

A summary of Measurement Conditions and Metric Preferences follows. **ΔE (CMYK)** is used to calculate the color difference between process colors. **ΔE (SPOT)** is used to calculate the color difference between spot colors. Measured densities rely on the **filter setting** (ANSI A or similar) and may be absolute or paper relative.
All metric preferences are accessible through **Edit > Preferences...** on the main Curve Pilot menu. See *Application Preferences* on page 73 for the details.

### 6.3.2 Measuring a Control Strip Manually

To perform manual measurements on a control strip:

1. Click **Measure...** on the main PressSync window.
2. Select a control strip of a production sheet on the **Measure** dialog.
3. Verify that the PressSync dgc curves listed in the **Used Curves** tab are the ones actually used for printing your control strip. If not, enable (check) **The production sheet is printed with different PressSync Curves** and enter the correct curve(s) including Min and Max values.
4. Measure the **process color patches** on the **Process Colors** tab.
5. Measure the **gray patches** on the **Gray Balance** tab.
6. If your control strip contains spot colors, measure the **spot color patches** on the **Spot Colors** tab.

### Process Colors

To measure process color patches on a production control strip:

1. Make a note of the **measured quantity for process colors in your setup**. Verify that your measuring device is set to measure the same quantity. This is commonly %DotArea in `cmyk_` templates and `density` in `3ck_` templates, but another metric may be used instead.
2. If you are working with a `cmyk_` template, measure the 0% patch, the 100% (solid) patch, and all intermediate patches for Cyan, Magenta, Yellow, and Black.
3. If you are working with a `3ck_` template, measure the 0% patch, the 100% (solid) patch, and all intermediate patches for CMY (3c gray) and Black.
4. Enter your measurements in the **Process Colors** tab. Press **Tab** to quickly move from one input field to the next.

### Gray Balance

To measure gray patches on a production control strip:

1. Measure the 0% patch and enter the measured Lab values in the **L**, **a**, and **b** fields. Press **Tab**.
2. Measure the 100% (solid) patch and enter the measured Lab values in the corresponding **L**, **a**, and **b** fields. Press **Tab**.
3. Measure each intermediate gray patch and enter the measured Lab values in the corresponding **L**, **a**, and **b** fields.

### Spot Colors

To measure spot color patches on a production control strip:
6.3.3 Measuring the Universal Target Manually

To perform manual measurements on the universal target:

1. Click Measure... on the main PressSync window.
2. Select Universal Target on the Measure dialog.
3. Verify that the PressSync dgc curves listed in the Used Curves tab are the ones actually used for printing the universal target. If not, enable (check) The Universal Target is printed with different PressSync Curves and enter the correct curve(s) including Min and Max values.
4. Measure the process color vignettes on the Process Colors tab.
5. Measure the paper and gray squares on the Gray Balance tab.

Process Colors

To measure process color vignettes on the universal target:

1. Make a note of the measured quantity for process colors in your setup. Verify that your measuring device is set to measure the same quantity. This is commonly %DotArea in cmyk_templates and density in 3ck_templates, but another metric may be used instead.
2. For each process color vignette (Cyan, Magenta, Yellow, and Black if you are working with a cmyk_template; CMY (3c gray) and Black if you are working with a 3ck_template) on the universal target:
   a. Locate the solid patch at position 100 on the vignette and measure it. Enter the measured value in the Measured Solid <quantity> input field.
   b. For each intermediate patch composition (i.e. 25%, 50%, 75%):
      • Make a note of the desired value. Desired values are displayed on the vignette:
      • Measure around the intermediate composition until you have found the desired value.
      • Note the position on the vignette where you have located the desired value.
      • Enter this position in the corresponding quantity of desired value found at input field.

Note: Press Tab to quickly move from one input field to the next.

Gray Balance

On the Gray Balance tab for the universal target:
1. Measure the Substrate (Paper) and enter the measured Lab values in the L, a, and b input fields. Press Tab.

2. Note the desired Lab value for the Dark Square. This is shown on the square:

![Image of Dark Square](image)

3. Measure around this area on the Dark Square until you have found the desired Lab value.
4. Enter the coordinates of the Dark Square where you have located the desired Lab value.

![Image of Dark Square coordinates](image)

5. Repeat steps (2)-(4) for the Light Square on the universal target.

### 6.4 Saving PressSync Results

To save PressSync results, click Save on the Measure dialog. You will be prompted to Save curves or Save measurements only.

**Note:** Save curves saves the measurements in memory and sets the calculated dgc curves as the used curves.

Save measurements only does not update the used curve set. This action generates an incomplete (不得转载) record item in the history log. See History of PressSync Results on page 51 for the details.

### 6.5 Interpreting PressSync Results

To view PressSync measurements and results, click on Go to Results on the Measure dialog.

On the PressSync results window, you can:

1. Review the ink solids on the Overview Ink Solids tab.
2. Review measurements and results for the process colors on the Process Colors tab.
3. Review measurements and results for the spot colors on the Spot Colors tab.

**Important:** Inspect the Overview Ink Solids results first. Large deviations of the measured ink solids values from the desired ink solids values imply that the calculated PressSync dot gain compensation curves should be used with extreme caution.
Click Report to examine and optionally print a combined view of the results shown under the Overview Ink Solids, Process Colors, and Spot Colors tabs.

6.5.1 Overview Ink Solids

The Overview Ink Solids tab summarizes the color difference between measured and desired ink solids colors, using the ΔE formulas specified in the Curve Pilot Application Preferences. You can click Preferences... to access the relevant subset of application preferences from within the Overview Ink Solids tab.

Measured Lab values plus chroma/saturation (C) and hue (h) for ink solids colors are extracted from measurements. Desired Lab values plus chroma/saturation (C) and hue (h) for ink solids colors are extracted from the desired printing condition for the specific curve set.

Color differences for process inks are calculated using the ΔE (CMYK) formula, while color differences for spot inks (non-cmyk inks) are calculated using the ΔE (SPOT) formula. If a color difference exceeds the tolerance value set in the Preferences (see ΔE (CMYK) Tolerance and ΔE (SPOT) Tolerance), the color difference value is indicated in red preceded by ‘>’. Density differences between measured and desired ink solids are displayed in the ΔDensity column. Measured density values are extracted from measurements using the density filter and paper settings set in the Preferences, and the desired density is extracted from the desired printing condition.

Important: If the desired printing condition profile does not contain spectral data, the desired density cannot be extracted. In that case the Desired Density column and the ΔDensity column will be marked as ‘--’.

6.5.2 Process Colors

On the left panel of Process Colors tab for viewing results, you can review:

1. Tone measurements
2. Gray balance measurements
3. Calculated dgc curves
On the rightmost area/panel you can review:

1. The **advanced settings** for calculating PressSync compensation curves
2. A summary of the calculated dgc curves

**Tone Measurements**

The **Tone Measurements** tab summarizes measured versus desired data for each ink present in your setup.

The top half of the **Tone Measurements** tab displays these tabulated values in graphs organized under more tabs for **All Inks** and for each process ink separately. On each graph, solid lines indicate desired values; data points indicate measurements.
The bottom half of the **Tone Measurements** tab displays measured versus desired data in a tabular format. Solid black lines of text indicate measured results. Gray lines of text indicate desired values. The numerical values displayed depend on the setting of **Measure** on the **Process Colors** setup tab (see Select the Desired Dot Gain Metric on page 52).

When working with a cmyk template, and the setting for **Measure** on the **Process Colors** setup tab is %DotArea or %ΔE–SP, tone value increase (TVI%) graphs are shown by default. To switch to the usual dot gain graphs, uncheck (disable) the **Show TVI** option.

TVI graphs are not relevant in the case of 3ck_ templates.
**Extra Info:** Curve Pilot calculates TVI% depending upon the setting of **Measure**.

For %DotArea:

\[
\text{TVI\%} = \%\text{DotArea} - \%\text{TV}
\]

where %TV is a tone value percentage (patch composition), and %DotArea is the measured dot area at that tone value.

Similarly for %ΔE-SP:

\[
\text{TVI\%} = \%\text{ΔE-SP} - \%\text{TV}
\]

where %ΔE-SP is the measured colorimetric value at %TV.

**Gray Balance Measurements**

The **Gray Balance Measurements** tab summarizes measured versus desired values for cmy-composed gray patches. See **Gray Balance Calculations** on page 55 for the details.

The top half of the **Gray Balance** tab displays measured and desired values graphically. Measured a* values are shown as data points in red; desired a* values are shown as a solid / dashed line in red. Measured b* values are displayed as data points in blue; desired b* values are shown as a solid / dashed line in blue. The transition of these target a*, b* lines from solid to dashed indicates the gray balance feather-off start (a user-defined tone value that marks the start of gradual reduction for gray balance compensation). For the details see **Gray Balance Feather-Off** on page 57.

The difference between measured and desired L* values is displayed as a weighted delta Lightness line in black. Similarly, the difference between measured and desired Chroma/hue is displayed as a weighted delta Chroma/hue line in green. These can be useful in assessing how
far the measured patches are from the perceived natural color scales specified in the desired printing condition (target). Ideally they should be straight horizontal lines close to zero.

The bottom half of the **Gray Balance** tab displays measured versus desired data in a tabular format. Solid black lines of text indicate measured results. Gray lines of text indicate desired values. The numerical values displayed are colorimetric (Lab values).

**Calculated Curves**

The **Calculated Curves** tab summarizes the compensation curves calculated by Curve Pilot for each process ink present in your setup.

Calculated curves are shown for **All Inks** under the same tab, and for each process ink separately on dedicated tabs.
In the case of cmyk templates, these curves are by default calculated from compensation points for tone only; in the case of 3ck templates, they are by default calculated from compensation points for gray balance only.

To view what type of compensation is taken into account to calculate the curves, check the value of Select curves based on in the advanced Curve Pilot settings for calculating PressSync curves. See also Advanced PressSync Settings on page 49.

Enable Show tone and gray compensation points to view tone compensation points (in blue) and gray compensation points (in gray) on any compensation graph. For the details see Gray Balance in CMYK Templates on page 59.

Notice that a calculated compensation curve set automatically replaces the currently used curve set in Curve Pilot.
The calculated curves shown under **New Curve** in the results become the updated **Used Curve** set for the next measurement action.

**Advanced PressSync Settings**

Before you work with the advanced PressSync settings for calculating compensation curves, it is recommended that you have thoroughly read (and understood) the *Advanced PressSync Topics* on page 55 sections in this guide. The initial settings used by Curve Pilot provide sensible defaults.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Select curves based on</strong></td>
<td>Select curves based on Tone Measurements only (compensation for tone), or Mainly Gray Balance Measurements (compensation for gray balance), or Both Tone and Gray Balance Measurements (a combination of compensation for tone as well as gray balance). See <em>Gray Balance in CMYK Templates</em> on page 59.</td>
</tr>
<tr>
<td><strong>Gray Balance Control Options</strong></td>
<td></td>
</tr>
<tr>
<td>Use gray finder</td>
<td>Control how compensation for gray balance is calculated. See <em>Gray Finder Method</em> on page 56 and <em>Linear Method</em> on page 56.</td>
</tr>
<tr>
<td>Gray Control Feather-Off Start</td>
<td>Define the range of tonal values where compensation for gray balance will be gradually reduced (feathered-off). See <em>Gray Balance Feather-Off</em> on page 57.</td>
</tr>
<tr>
<td>Gray Control Feather-Off End</td>
<td></td>
</tr>
<tr>
<td>Black Aimpoint (a<em>b</em>)</td>
<td>Determine the method used in feathering-off compensation for gray balance.</td>
</tr>
</tbody>
</table>
### 6.5.3 Spot Colors

Curve Pilot displays tone measurements for spot colors in the same way as tone measurements for process colors. See the section on [tone measurements for process colors](#) for the details.

In the case of spot colors, the **advanced gray balance options** are not applicable; curves are by default calculated from compensation points for tone.

See the section on viewing [calculated curves for process colors](#) for the details.

### 6.6 Exporting PressSync Results

Curve Pilot can export calculated dot gain compensation curves for each process and spot color in your setup in the `.dgc` file format, and a combined compensation **strategy** for all colors in the `.icpro` file format.

The `.prsync` curve set and its corresponding `.icpro` strategy can be used interchangeably within the Imaging Engine application. However, an `.icpro` strategy can be expanded by adding specialized `.dgc` rules for different sets of screening parameters. For the details see [Creating a Strategy](#) on page 62.

To export PressSync results:

1. Click **Export Curves...** on the **Process Colors** tab of the Curve Pilot window when viewing results.
2. On the **Export Curves** dialog, enter a common **Prefix** for all `.dgc` files and for the `.icpro` file. You can **Overwrite existing files**, or enter a unique **Prefix**. All files will be saved in the **central location of dgc data**.
3. Click **OK**. Curve Pilot will display the list of generated files on the **Info Export Curves** dialog.

**Extra Info:** Curve Pilot composes file names from the prefix, the name of the `.prsync` file, the type of PressSync template (cmyk/tone or 3ck/gray), and the color name:

```
<prefix>_<prsyncFileName>.icpro
<prefix>_<prsyncFileName>_Comp_<Tone|Gray>_<colorName>.dgc
```

For the example file `myprsync.prsync` based on a cmyk template without spot colors, the following files are generated by default:

<table>
<thead>
<tr>
<th>File Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>tmp_myprsync.icpro</td>
</tr>
<tr>
<td>tmp_myprsync_Comp_Tone_Cyan.dgc</td>
</tr>
<tr>
<td>tmp_myprsync_Comp_Tone_Magenta.dgc</td>
</tr>
<tr>
<td>tmp_myprsync_Comp_Tone_Yellow.dgc</td>
</tr>
<tr>
<td>tmp_myprsync_Comp_Tone_Black.dgc</td>
</tr>
</tbody>
</table>
6.7 History of PressSync Results

The **History** tab displays a list of previously saved *setup changes, manual curve changes*, and *measurement actions*.

For each item on the history list, you can review its 'state' (column), type of action (*Action* column), resulting compensation curves (*Curves* column), and timestamp (*Date* column). Most recent items are shown first.

The **action type** can be one of *Setup Change*, *Manual Curve Change*, *Measured Automatic*, *Measured Universal Target*, or *Measured Control Strip*.

A history item can be active (✓), active but incomplete (✓), inactive and incomplete (✓), or inactive and disabled (grayed-out) because it is superseded by a more recent setup change.

Only items of type *Measured Automatic*, *Measured Universal Target*, and *Measured Control Strip* can be indicated as active but incomplete (✓) or inactive and incomplete (✓); this means that the measuring action was completed but the resulting (computed) compensation curves were not set as the ones used for printing subsequent jobs.

You can select an item on the history list and:

- Make it the active item; click **Set Active**.

  **Note:** Setting a disabled but completed measurement action (grayed-out) into active (✓) sets the resulting (computed) compensation curves as the compensation curves to be used for subsequent measurement actions.

  Setting an inactive and incomplete measurement action (✓) into active (in this case ✓) does not set the resulting (computed) compensation curves as the compensation curves to be used for subsequent measurement actions.

  You can always view the curves used in measurements on the **Select Curve Names** dialog.

- View information on the item; click **Show Info**.

  **Note:** For a setup change, a read-only version of the **Setup** dialog will be displayed. For a measurement action, the usual window for viewing results will be displayed.

- Delete the item; click **Remove**.

  **Note:** You cannot delete the active item (✓) or the last setup change linked to the active item, or a setup change linked to a measurement action (you have to delete the measurement action first).

6.8 Customizing PressSync Templates

Curve Pilot lets you setup your *prsync* template in a variety of ways. The following Table summarizes the most common template customizations and a few representative use cases:
<table>
<thead>
<tr>
<th>Setup Change</th>
<th>Use Case</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Add or remove spot colors</strong> from the template</td>
<td>Printing to Equinox or another custom system requiring special inks</td>
</tr>
<tr>
<td><strong>Select the desired measured quantity</strong> for process or spot colors</td>
<td>Adjusting the measured dot gain metric to in-house measuring device capabilities and standards; see also Application Preferences and Dot Gain Metrics in Curve Pilot</td>
</tr>
<tr>
<td><strong>Select the desired printing condition</strong> for the PressSync template</td>
<td>Using a recently developed profile or a new data characterization set; generating custom in-house PressSync templates based on the ones provided with the application</td>
</tr>
<tr>
<td><strong>Select the desired dgc curves</strong> for any process or spot color in the template</td>
<td>Customizing dgc curves for flexo printing; adjusting ISO 12647-2/3 curves (offset) to another printing technology</td>
</tr>
<tr>
<td><strong>Set the desired densities of paper and solid</strong> for any process or spot color in the template</td>
<td>Using a desired printing condition (profile or data characterization set) that does not provide spectral data</td>
</tr>
<tr>
<td><strong>Set custom targets for gray balance</strong></td>
<td>Customizing desired colorimetric values employed in dot gain compensation for gray balance; setting custom in-house gray balance targets; see also Gray Balance Calculations in Curve Pilot</td>
</tr>
</tbody>
</table>

To start customizing your PressSync template, click Setup... on the main PressSync window.

### 6.8.1 Add or Remove Spot Colors

To add or remove a spot color in your PressSync template, go to the Spot Colors tab of the Setup dialog.

To add a spot color to your curve set, click + and follow the instructions on the Choose Ink... dialog.

To remove a spot color from your curve set, select it and click -.

### 6.8.2 Select the Desired Dot Gain Metric

Curve Pilot understands dot gain measurements in a variety of units. You can find the details under Dot Gain Metrics on page 72.

To set the desired measured quantity for process colors:

1. Go to the Process Colors tab of the Setup dialog.
2. Select the desired measured quantity under the Measure drop-down selection list. The default values are %DotArea for cmyk_ templates, and density for 3ck_ templates.

To set the desired measured quantity for a spot color:

1. Go to the Spot Colors tab of the Setup dialog.
2. Select a spot color under the Spot Colors list.
3. Select the desired measured quantity under the Measure drop-down selection list. The default value is ΔE-97.
Notice that individual spot colors can have different dot gain metrics.

6.8.3 Select the Desired Printing Condition

To generate a PressSync template for a printing specification / standard not implemented in Curve Pilot, or to combine printing targets from more than one printing specifications / standards (e.g. GRACoL and ISO 12647-2 Type 1, SWOP and ISO 12647-2 Type 3), you will normally want to change the desired printing condition of your PressSync template:

1. Go to the General tab of the Setup dialog.
2. Click Change... next to the Desired Printing Condition text field.
3. Select the Profile Type for the new Desired Printing Condition. This can be an ICC Profile, an Esko Profile, or a Fogra Characterization Data set.

**Extra Info:** Profiles are stored in the central location of CMS data, i.e. `\server/bg_data_cms_v010/`.

4. Click to review a summary of the profile.
5. Enter a short description for your new curve set in the Curve Set Description area. A useful curve set description includes information about your printing standard, desired dot gain values, paper type, screen/ruling parameters, and/or any other specific operating conditions.

6.8.4 Select the Desired Dot Gain Curves

By default, Curve Pilot extracts desired dot gain curves from the printing standard associated with your curve set template. If you are working with a cmyk template, you can set desired (target) dot gain curves for each process color (c,m,y,k) separately. If you are working with a 3ck template, you can only set desired dot gain curves for cmy-composed gray (3c) and black (k).

If you enable Extract curves from desired printing condition, desired curves will be extracted automatically from the profile (or data characterization set) specified as the Desired Printing Condition under the General tab. The resulting dot gain curves will normally be very close to the ones extracted directly from the template's standard, albeit not identical.

**Note:** You may want to enable Extract curves from desired printing condition if your desired printing condition is a profile containing spectral data. This way, reliable density values will be calculated from the spectral data.

To change the desired dot gain curve for a process color:

1. Go to the Process Colors tab of the Setup dialog.
2. If the Desired Curves panel is collapsed, click on to expand it.
3. If you are working with a cmyk template, select the desired (reference) dot gain curve from the drop-down selection list for Cyan, Magenta, Yellow, or Black.

   If you are working with a 3ck template, select the desired (reference) dot gain curve from the drop-down selection list for CMY (3c gray) or Black.

   In both cases, you can select a custom desired dot gain curve specified in a .dgc file, a Linear dot gain curve, or a User Defined dot gain curve.
**Curve Pilot**

Note: Generating a User Defined dot gain curve for a process color requires entering target dot gain values manually. For the details, see *User Defined Dot Gain Curves for Process Colors* on page 84. This process is deprecated and no longer recommended. You can always import custom reference dot gain curves specified in .dgc files instead.

4. Click to preview the curve.

To change the desired dot gain curve for a spot color:

1. Go to the **Spot Colors** tab of the **Setup** dialog.
2. Select a spot color from the **Spot Colors** list.
3. Select the desired (reference) dot gain curve for the selected spot color from the **Desired Curve** drop-down selection list.

   You can choose between a **Linear curve**, a **User Defined curve**, or the curve that Curve Pilot will **Calculate from ink profile** automatically.

Note: Generating a User Defined dot gain curve for a spot color requires entering target dot gain values manually. For the details, see *User Defined Dot Gain Curves for Spot Colors* on page 84.

4. Click to preview the curve.

### 6.8.5 Set the Desired Densities of Paper and Solid

Note: You do not need to enter desired density values for paper or solid if your **desired printing condition** is a profile containing spectral data. Curve Pilot will calculate reliable density data from the spectral data automatically.

To quickly check if your profile contains spectral data, click on next to the **Desired Printing Condition** field on the **General** tab of the **Setup** dialog.

If your desired printing condition is (a) an ICC profile, or, (b) a characterization data set without spectral data, you may want to edit the values for the paper and solid densities. These values do not affect the final dot gain compensation curves calculated by Curve Pilot.

To change the desired densities for paper and solid for process colors:

1. Go to the **Process Colors** tab of the Setup dialog.
2. If the **Desired density of Paper and Solid** panel is collapsed, click on to expand it.
3. If you are working with a **cmyk** template, enter the desired densities for **Cyan**, **Magenta**, **Yellow**, or **Black** under **Paper** and **Solid**.

   If you are working with a **3ck** template, enter the desired densities for **CMY** (3c gray) or **Black** under **Paper** and **Solid**.

   Note: Make sure that you enter process colors paper and solid **density values** when the dot gain metric in the **Measure** drop-down selection list is either **density** or **%DotArea**. Enter **ΔE-P** values when the dot gain metric in the **Measure** drop-down selection list is either **ΔE-P** or **%ΔE-SP**.

To change the desired **ΔE-P** values for paper and solid for spot colors:

1. Go to the **Spot Colors** tab of the Setup dialog.
2. Select a spot color from the **Spot Colors** list.
3. Under **Desired ΔE-P for Paper and Solid**, enter the desired **Paper** and **Solid** values for the selected spot color.

**Note:** Make sure that you enter spot colors paper and solid ΔE-P values when the dot gain metric in the **Measure** drop-down selection list is either ΔE-P or %ΔE-SP. Enter density values when the dot gain metric in the **Measure** drop-down selection list is either density or %DotArea.

### 6.8.6 Set Custom Targets for Gray Balance

To modify the desired Lab values (colorimetric targets) of cmy-composed gray patches, go to the **Gray Balance** tab of the **Setup** dialog.

If you are working with a cmyk_ template and you will be compensating for tone only, you do not need to worry about these settings. For the details, see **Advanced PressSync Settings** on page 49 and **Gray Balance in CMYK Templates** on page 59.

If you are working with a 3ck_ template (or if you are working with a cmyk_ template and want to compensate for gray balance in addition to tone):

1. If you set your gray balance **Aim** to the profile serving as the **Desired Printing Condition** under the **General** setup tab, desired values are extracted from the profile by default.
   - In this case you can only modify the number of intermediate **Patches** (excluding paper and solid) on the control strip, and the compositions of these intermediate patches.

2. If you set your gray balance **Aim** to **Paper Relative** or **User Defined**, you can also:
   - a. Modify the Lab values for paper and solid under the **Desired Values on the Universal Target** and **Desired Values on a Control Strip** panels.
   - b. Modify the desired Lab values for Cyan, Magenta, and Yellow solids under the **Desired Values of the Solid Process Colors** panel.

3. If you set your gray balance **Aim** to **User Defined**, you can additionally modify the desired Lab values of all gray patches under the **Desired Values on the Universal Target** and **Desired Values on a Control Strip** panels.

**Note:** Setting your gray balance **Aim** to **User Defined** allows you to enter cmy triplets for gray patches that do not conform to the **Neutral Gray CMY Triplet Table** on page 86.

### 6.9 Advanced PressSync Topics

#### 6.9.1 Gray Balance Calculations

The G7 calibration method is based on adjusting curves towards perceived neutral gray scales. The measured data used by this method are mainly colorimetric. When the measured color of a **neutrally composed gray patch** (made of equal percentages of c, m, y) deviates from the desired neutral color, you have to correct / shift the individual c, m, y components to bring the color back to neutral. This is the principle behind **compensation towards gray balance**.
Curve Pilot has two different methods for obtaining curves that compensate towards gray balance: a linear method and a 'gray finder' method. Both are available under the **Gray Balance Control Options panel** on the Curve Pilot window when viewing results.

To enable the linear method, deselect **Use gray finder**. The **Use gray finder** control will be disabled if your measurements were made on control strip(s) not containing enough neutrally composed gray patches and/or enough 'gray finder' patches around them; see **Gray Finder Method** below.

### Linear Method

The linear method assumes a linear relationship between changes in color Lab values and changes in cmy components. Coefficients for this relationship are derived from the a and b values measured for the ink solids.

This method takes measurements from neutrally composed gray patches. The measured Lab values are compared to the desired Lab values that give neutral perceived scales. Compensation is calculated from the difference, using a linear relationship.

**Note:** This method is not suited for printing conditions that use inks with non-linear profiles, i.e. for inks whose measured a, b values do not scale linearly with tone. Also, if the measured a, b values are too far away from the desired/aim values, the calculated curves may not immediately result in neutral scales, and different print iterations may be required.

### Gray Finder Method

The gray finder method relies on additional 'gray finder' patches around the neutrally composed ones. It measures Lab values for the different cmy compositions around each neutral triplet, and constructs a lookup table of cmy compositions into Lab values. Finding the correct cmy triplet is then equivalent to looking up the desired a, b values in the table.

The **P2P25** calibration target is especially suited for this method: it contains several neutrally composed gray patches, and 'gray finder' patches around them.

This method can also be used when profiles are used as measurement data. The Lab values of gray finder patches are then extracted from the profile by interpolation.

### Relative Lightness

Curve Pilot uses the latest G7 method for calculating desired/aim a, b values for any neutrally composed cmy-triplet. In simple terms, this method multiplies the a, b values of the standard paper by the relative lightness of the cmy-triplet.

The relative lightness (RL) of each triplet is calculated by the following formula:

$$RL = \frac{(L_{\text{triplet}} - L_{300})}{(L_{\text{paper}} - L_{300})}$$

where $L_{\text{triplet}}$ is the desired/aim L value of the triplet, $L_{\text{paper}}$ is the L value of the standard paper, and $L_{300}$ is the desired/aim L value of the 100% cmy patch (Cyan=100%, Magenta=100%, Yellow=100%).
The effect on the **Gray Balance Measurements** graph is that a, b aim lines in the graph may not be perfectly straight lines. The a, b aim lines will be more curved (or piecewise straight) when using paper with more color (higher a or b).

### 6.9.2 Gray Balance Feather-Off

**Why Feather-Off Gray Balance**

The G7 method specifies that color of neutral scales should go from paper to perfectly achromatic; the 100% cmy patch (c=100%, m=100%, y=100%) should measure a=b=0.

On most real printing conditions, the 100% cmy patch is not perfectly achromatic. To compensate for that, one or more of the c, m, y components of the 100% cmy patch would need to be screened, and this is mostly unwanted (screened solids are generally undesirable).

Because we do not want to screen at 100% cmy, and because we want a smooth transition towards slightly colored 100% cmy, we have to **feather-off** (gradually reduce) gray balance correction in the shadows.

Curve Pilot provides two different methods to this end. The first method gradually reduces the required cmy shifts / corrections. The second method gradually scales the aim values. Both are available under the **Gray Balance Control Options panel** on the Curve Pilot window when viewing results.

To enable the first method, select **G7:0 0** in the Black Aimpoint (a*,b*) drop-down selection box. To enable the second method, select **Measured** in the Black Aimpoint (a*,b*) drop-down selection box.

**Black Aimpoint Set to 'G7:0 0’**

This method keeps the a and b aims over the whole tonal range as specified by the G7 method, but from a certain gray tint onwards (the **Gray Control Feather-Off Start**) gradually reduces the required cmy shifts / corrections. The feather-off start is set at 50% by default. There is also a **Feather-Off End** tint, which is set at 100% by default.

On the **Gray Balance Measurements** chart you will notice that the a, b aim lines change into dashed lines at the tone value specified in Feather-Off Start.
The compensation curves obtained with this method fully correct gray balance in the highlights and mid tones; in the shadows, gray tints gradually follow the natural overprint behavior of the inks.

You can verify this in the Calculated Curves graphs in Curve Pilot, by selecting the Show tone and gray compensation points option. Tone compensation points are shown in blue, gray compensation points are shown in gray. The final adjustment curve fits the gray compensation points very well up to the feather-off tone; after the feather-off tone, it gradually fits the tone compensation points (in blue) better.

Black Aimpoint Set to 'Measured'
This method linearly scales the a, b aim values towards the a, b values measured for the 100% cmy patch.

On the Gray Balance Measurements chart you will notice that the a, b aim lines remain solid, but their slope changes at the tone value specified as feather-off start.
The curves obtained from this method give rise to neutral color scales in the highlights and mid tones, and to colors linearly shifting towards the measured 300% cmy patch from the feather-off tone onwards.

On the adjustment curves calculated from this method, you will notice that the curves now fit the gray points (the compensation points towards gray balance) over the whole tonal range. You will also notice that past the feather-off start, these gray points gradually become linear (X=Y). That is expected; as aim values gradually go towards measured values, required compensation diminishes.

### 6.9.3 Gray Balance in CMYK Templates

#### CMYK Based Curve Sets and Gray Balance Calculations

The way Curve Pilot calculates compensation points for tone and compensation points for gray balance is different depending upon the curve set template at hand. These differences are summarized in the following Table.

<table>
<thead>
<tr>
<th>Compensation Type</th>
<th>cmyk Template</th>
<th>3ck Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tone</td>
<td>Compensation is calculated from desired tone value increase (TVI) curves specified in an ISO standard</td>
<td>Compensation is calculated from density or L target values extracted from G7 neutral print density (NPDC) curves</td>
</tr>
<tr>
<td>Gray Balance</td>
<td>Compensation is calculated from desired a, b values, and also L target values extracted from G7 neutral print density (NPDC) curves</td>
<td>Compensation is calculated from desired a, b values only (see Gray Balance Calculations on page 55)</td>
</tr>
</tbody>
</table>

When creating new curve sets from a cmyk template, Curve Pilot by default calculates compensation curves for tone only. You can verify this on the Curve Pilot window when viewing results: the setting for Select curves based on should be Tone Measurements only.
To obtain compensation curves taking into account gray balance, change the default setting to either Mainly Gray Balance Measurements or Both Tone and Gray Balance Measurements.

**Mainly Gray Balance Compensation in CMYK Curve Sets**

With this setting, you can influence compensation towards gray balance in the highlights, and switch to compensation towards tone in the midtones and/or shadows. The transition point will depend on the gray balance feather-off method used. See also *Gray Balance Feather-Off* on page 57.

When the black aimpoint is set to $G7:0,0$ in the Black Aimpoint ($a^*,b^*$) selection box (see *Black Aimpoint Set to 'G7:0 0'* on page 57), compensation for gray balance starts to fade out at the Feather-Off Start tone. After that tone, compensation gradually moves towards the desired TVI curves.

When the black aim-point is set to Measured (see *Black Aimpoint Set to 'Measured'* on page 58), compensation for gray balance starts to fade out at the Feather-Off End tone. After that tone, compensation gradually moves towards the desired TVI curves.

When you examine press test runs with compensation curves calculated towards mainly gray balance targets, you may notice two distinct areas in the Tone Measurements TVI graphs: a highlights / midtones area where the desired tone values are not met very well, and a midtones / shadows area where measured dot gain follows the desired TVI curves very well.

**Both Tone and Gray Balance Compensation in CMYK Curve Sets**

With this setting, compensation towards both tone and gray balance will applied over the whole tonal range and averaged evenly.
Curve Pilot

7. Working with DGC Strategies

7.1 What is a Strategy?

Dot gain within the same print job can vary depending upon the screening parameters, inks, and other factors. A dot gain compensation strategy allows you to use different dgc curves on different areas of the film or plate, taking into account different inks (separations), screening parameters, and compensation requirements for continuous tone images (CT) vs. line work (LW).

A complete dgc strategy provides a compensation curve for every practical combination of inks, screens, and/or any other operating parameters affecting dot gain used on your press, and links the right compensation curve to each applicable set of operating conditions.

Note: Curve Pilot saves dgc strategies in the .icpro file format.

If you are familiar with former versions of Curve Pilot, you have already created screen-based strategies in the .scrdgc file format. It is not possible to create .scrdgc files any more, but you can still use them by importing them (File > Import > SCRDGC).

It is also possible to migrate .scrdgc files in one go with the Migration Tool. For more information on this topic, see Migration Tool for SCRDGC Files on page 85.

You do not need a separate dgc strategy for each new print job. Well-designed strategies are applicable to many jobs as long as the printing circumstances / operating conditions are similar. In many cases one strategy per press and per resolution of the image setter is sufficient, and most prepress operators require no more than 10-30 strategies in total.

7.1.1 Simple Ink-Based Strategies

You can employ simple ink-based strategies when you are primarily interested in compensating dot gain on different separations/inks differently.

In practice this is often the case with yellow, where dot gain compensation is much less needed, and with black, where for example softer flexo plates may require different bump-up settings in the highlights.

But you can also employ more complex strategies to distinguish between parts of the job based on dot shapes, screen rulings and angles, or the presence of contones (CT) and linework (LW). These are combined ink- and screen-based strategies.

7.1.2 Combined Ink- and Screen-Based Strategies

You can use combined ink- and screen-based strategies to apply specialized dot gain compensation curves to parts of your job based on additional screening parameters. The screening parameters that you can use to specialize your strategy, and a few representative use cases, are shown in the Table below.
7.2 Creating a Strategy

To create a new strategy, select `File > New > Strategy (.icpro)` from the main Curve Pilot menu. On the strategy editing dialog that comes up, you can create a rule-based (decision) tree by inserting nodes for different inks, dot shapes, screen rulings, screen angles, and contone/linework. Select `File > Save As...` to save your strategy with a desired name.

<table>
<thead>
<tr>
<th>Type of Action</th>
<th>Click</th>
<th>Function</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add ink rule</td>
<td><img src="image" alt="Add Ink" /></td>
<td>Add any number of inks from any ink book known to the system that require a separate dgc curve.</td>
<td>This action generates an Other Inks node by default, if one is not already present at the same level.</td>
</tr>
<tr>
<td>Add process inks rules</td>
<td><img src="image" alt="Add Process Inks" /></td>
<td>Use as a shortcut for adding c,m,y,k ink branches to the tree.</td>
<td>This action generates an Other Inks node by default, if one is not already present at the same level.</td>
</tr>
</tbody>
</table>

**Note:** Use the Other Inks node to group all inks requiring the same dgc curves.
### Curve Pilot

<table>
<thead>
<tr>
<th>Type of Action</th>
<th>Click</th>
<th>Function</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add dotshape rule</td>
<td>![dot]</td>
<td>Add any number of dot shapes that require a separate dgc curve from the drop-down selection list.</td>
<td>This action generates an Other Dotshapes node by default, if one is not already present at the same level.</td>
</tr>
<tr>
<td>Add screen ruling</td>
<td>![rule]</td>
<td>Add any number of screen rulings (ipi) that require separate dgc curves.</td>
<td>The default lpi for a new node is 100. Double click on it to edit the value. Permissible values are [10..10000] lines per inch.</td>
</tr>
<tr>
<td>Add screen angle</td>
<td>![angle]</td>
<td>Add any number of screen angles that require separate dgc curves.</td>
<td>The default angle for a new node is 7.5. Double click on it to edit the value. Permissible values are [0..180] degrees.</td>
</tr>
<tr>
<td>Add images / linework rule</td>
<td>![images]</td>
<td>Add different dgc curves for contones (images) and linework.</td>
<td>This action generates a CT and a LW node by default.</td>
</tr>
<tr>
<td>Delete node</td>
<td>![delete]</td>
<td>Delete the selected node.</td>
<td>This action may delete all nodes below the currently selected one.</td>
</tr>
</tbody>
</table>

For each new rule / node in the tree, the default dgc curve is set to `<none>`, implying no compensation. Click on `<none>` to select a different compensation curve from the drop-down selection list.

The order of adding / deleting nodes in the tree is not important, but a few ground rules apply:

1. All top level nodes must be of the same type.
2. All subsequent level nodes under the same parent node must be of the same type.
3. Deleting a node may automatically delete its children to ensure that rules (1) and/or (2) still apply.
4. A new node is added:
   a. At the same level with the currently selected node, when both nodes are of the same type.
   b. Below the currently selected node, when the new node and the children of the currently selected node are of the same type.
   c. Above the currently selected node, when the new node and the parent of the currently selected node are of the same type.

With these simple rules in mind you can create complex strategies for your particular operational needs. The picture below shows a strategy treating black and other inks differently, and making use of stochastic and classic screening with various lpi's in the case of classic screening.
7.3 DGC Strategies and PressSync Curve Sets

Curve Pilot lets you use PressSync curve sets within strategies. This way you do not need to create ink-based strategy rules one by one.

To use an existing PressSync curve set within a strategy rule, make sure that you select \( \square \) as the curve type for your strategy rule first.

You can find an example of a strategy built from PressSync curve sets below:
In the highlighted strategy rule, a PressSync curve set is used, avoiding the need to create separate rules for each process color.

### 7.4 How the RIP Retrieves the Right DGC Curve

It is important to understand how a RIP application interprets an .icpro strategy.

Your job contains objects characterized by a set of attributes: CT/LW, separation, dot shape, ruling (lpi), screen angle. Depending upon your editing application, these may be set on a job-wide basis, or on an object-specific basis. Either way, the RIP application goes over all objects in your job and determines the best matching compensation curve in the strategy for each object present in the job.

The strategy shown below distinguishes between black and other separations, then distinguishes again between stochastic (Monet/FM) and classic (AM) dot shapes. The strategy defines different dgc curves for different rulings (lpi values) in the case of classic dot shapes.
When the RIP application encounters a cyan object, it searches for additional object attributes under 'Other Inks'. If the object's dot shape attribute is set to 'Monet', no dgc curve is applied in rasterizing the object; if the object's dot shape attribute value is 'Circular (Euclidean)', the best matching dgc curve is selected based on ruling (lpi).

If the object's ruling attribute is set to a value other than the exact ones specified in the strategy (that is, one of 85/100/120/133/150), then the closer lpi value determines the dgc curve to use in rasterizing the object. In our particular example, an object with lpi set to 110 is processed with `cdi_lin_100.dgc`, as lpi=100 is the closest lpi value specified in the strategy.

To preview which dgc curve is applied on parts of your job based on context (CT/LW, separation, dot shape, ruling, screen angle), you can use the Preview Combined Curves tool in Curve Pilot.
8. The Preview Combined Curves Tool

The **Preview Combined Curves** tool lets you preview the combined compensation result of multiple curves on a print job. The tool lets you select one compensation strategy (.icpro) or PressSync curve set (.prsync) for the press, an additional dot gain compensation curve (.dgc) for the press, as well as a separate compensation strategy (.icpro) or curve set (.prsync) for the plate.

You can use **Preview Combined Curves** to *preview a combination of curves* and to simulate a print job compensated by multiple curves, in a fashion similar to performing a simple (one curve) *Print simulation* in the Curve Pilot editor.

Additionally, you can use **Preview Combined Curves** to look into complex strategies (.icpro) and determine *which compensation curve is used based on context* (job parameters such as images / linework, separation, dot shape, ruling, and screening angle).

Finally, you can use **Preview Combined Curves** to *preview the stochastic range of SambaFlex screens* and the shifting of their transition points from stochastic to conventional grids. For more information about SambaFlex screens, please refer to the Esko screening manual(s).

### 8.1 Previewing a Combination of Curves

Add the desired curves, strategies, and/or PressSync curve sets under **Rip Dot Gain Compensation**:

1. Add an .icpro ink-based strategy or .prsync curve set for the press in the **Automatic Press** drop-down selection box.
3. Add an .icpro ink-based strategy or .prsync curve set for the plate in the **Automatic Plate Making** drop-down selection box.
4. Leave all settings under **Context** to default.

You can preview the resulting combined compensation curve in the **Combined Curves** area. Compensation data points are shown in the **Compensation Values** Table.

The order of evaluating compensation curves is shown in the **Compensation Values** Table and also on the **Curves** area:

1. The main press curve (**Automatic Press**) is applied first.
2. The extra press curve (**Single Curve Press**) is applied second.
3. The plate compensation curve (**Automatic Plate Making**) is applied last.

**Note:** You cannot change this evaluation order in Curve Pilot. If you are using Imaging Engine, you can change the order of applying the extra press curve; for the details, see your Imaging Engine manual.
Print Simulation

Add measured dot data saved in a .dgc file in the Plate Processing Simulation drop-down selection box. Enable the compensation curves to use under Curves. Make sure that step (4)>(5) under Curves is checked (enabled).

The Combined Curves graph now displays two curves: a combined compensation curve in blue, and a simulated dot gain curve in red. The simulated dot gain curve in red is the result of applying the combined compensation curve (blue) on the measured (normally uncompensated) data.

These measured data will normally form a dot gain curve that characterizes the plate processing phase of your workflow, but they can also appear in the form of a dot loss curve in the case of flexo printing, specifying how the plate wash-out process behaves.

Note: This preview is purely informative and final RIP results may not coincide with preview data.
8.2 Previewing the Results of a Strategy

An .icpro strategy can be complex and the compensation curve selected for a specific context (set up operating parameters) may not be immediately obvious by examining the strategy (see How the RIP Retrieves the Right DGC Curve on page 65).

The Preview Combined Curves tool lets you determine which compensation curve is used based on job parameters such as images / linework, separation, dot shape, ruling, and screen angle.

To use this feature:

1. Add the .icpro ink-based strategy for the press in the Automatic Press drop-down selection box.
2. Under Context, enter the job parameters for which you want to discover the compensation curve that will be used by the RIP application:
   a. Select between Images (CT) or Linework (LW).
   b. Select the Ink Name from an Ink Book.
   c. Select the Dot Shape.
   d. Enter the desired Ruling and Angle.

Example

A sample .icpro strategy contains special compensation curves for linework (all process inks) at 100 lpi and 120 lpi. You want to discover the compensation curve used for linework at 110 lpi.

Select the strategy name in Automatic Press, then under Context select Linework (LW) and enter 110 for Ruling. The right compensation curve is displayed in Curves.
8.3 Previewing the Stochastic Range of SambaFlex Screens

On the Compensation Values Table of the Preview Combined Curves dialog, you can preview the stochastic range of SambaFlex screens in the highlights and (possibly) in the shadows; both ranges will be highlighted in blue.

This feature is only available when you select a Dot Shape under Context from the HDFlexo family of screens (HD01...), or the SambaFlex family of screens (SC01...), or any other hybrid screen generated by the Screen Manager application (SCR01...). Make sure that Show stochastic range under SambaFlex Details is enabled (checked) as well.

Under SambaFlex Details, you can preview key parameters of the selected screen: Resolution in ppi, Dot Shape (same as the dotshape selected above), Actual Ruling in lpi, and Minimum Dot Size in pixels.

You can edit the values of Resolution and Minimum Dot Size to get an idea of the shifting of transition points. You may observe a trend: lower resolution to minimum dot size ratios give rise to broader stochastic ranges both in the highlights and in the shadows. This is to be expected; with a coarser setup (a lower resolution and/or a higher minimum dot size), the stochastic ranges have to move more into the midtones for the desired dot gain compensation effects to materialize.
9. Archiving DGC Data

You can pack any number of .dgc, .icpro, .scrdgc, and .prsync files into a single .icpack archive.

To create the archive, select **File > Pack...** from the top Curve Pilot menu, and follow the instructions on the **Pack** dialog. You can add any number of files to the archive and save it under the desired name and folder. You do not need to specify a file extension for the archive; the .icpack file extension will be appended automatically.

To unpack the archive, select **File > Unpack...** from the top Curve Pilot menu and follow the instructions on the **Unpack** dialog. The archived files will be extracted to the central location of dgc data. If you do not wish to overwrite files in that location, make sure that **Overwrite existing files** on the **Unpack** dialog is disabled (unchecked).
10. Appendices

10.1 Location of Data Files

The following Table summarizes the location of most common data files used by Curve Pilot. All paths are absolute. `\root` denotes the root installation folder of Curve Pilot, and `\server` denotes the central location of automation data. `\root` and `\server` may be identical.

The central location of dgc data is `\server\bg_data_dgc_v010`.

<table>
<thead>
<tr>
<th>File Type</th>
<th>Extension</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Characterization data set</td>
<td>.txt</td>
<td><code>\root\bg_data_intellicurve_v160\</code></td>
</tr>
<tr>
<td>Control strip layout description</td>
<td>.it8</td>
<td><code>\root\bg_data_intellicurve_v160\</code></td>
</tr>
<tr>
<td>Control strip file</td>
<td>.pdf</td>
<td><code>\root\bg_prog_intellicurve_v160\dat\doc</code></td>
</tr>
<tr>
<td>Dot gain compensation file</td>
<td>.dgc</td>
<td><code>\server\bg_data_dgc_v010\</code></td>
</tr>
<tr>
<td>Dot gain compensation strategy</td>
<td>.icpro</td>
<td><code>\server\bg_data_dgc_v010\</code></td>
</tr>
<tr>
<td>Dot gain compensation target</td>
<td>.dgc</td>
<td><code>\server\bg_data_dgc_v010\refdgc</code></td>
</tr>
<tr>
<td>Press sync curve set</td>
<td>.prsync</td>
<td><code>\server\bg_data_dgc_v010\</code></td>
</tr>
<tr>
<td>Screen dot gain compensation</td>
<td>.scrdgc</td>
<td><code>\server\bg_data_dgc_v010\</code></td>
</tr>
</tbody>
</table>

10.2 Dot Gain Metrics

Curve Pilot understands dot gain measurements in a number of units. These are summarized in the Table below.

<table>
<thead>
<tr>
<th>Unit</th>
<th>Min Val</th>
<th>Max Val</th>
<th>Description</th>
<th>Application Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>density</td>
<td>0</td>
<td>na</td>
<td>The optical density of reflected light</td>
<td>Use a densitometer set to the desired density filter for your region / specifications (see also Curve Pilot Preferences)</td>
</tr>
<tr>
<td>%DotArea</td>
<td>0%</td>
<td>100%</td>
<td>The amount of reflected light from a screened area, compared to paper and solid</td>
<td>Use a densitometer that can calculate %DotArea using the Murray-Davies equation</td>
</tr>
<tr>
<td>ΔE-P</td>
<td>0</td>
<td>na</td>
<td>ΔE-P is a colorimetric measurement indicating the color difference between a colored/inked patch and paper</td>
<td>Use a spectrophotometer with ΔE calculations set to CIE-1976 or more recent standard (see also Curve Pilot Preferences)</td>
</tr>
<tr>
<td>%ΔE-SP</td>
<td>0%</td>
<td>100%</td>
<td>%ΔE-SP is a colorimetric measurement indicating the</td>
<td>Use a spectrophotometer with ΔE calculations set to CIE-1976</td>
</tr>
</tbody>
</table>


10.3 Application Preferences

**Densitometer measures:**
Choose between Percentages and Densities. This setting must be consistent with the setting used in your measuring device, so that Curve Pilot can calculate dot gain compensation curves correctly.

**Number of Compensation Points:**
Set the number of calculated compensation points when generating dot gain compensation curves.

**ΔE (CMYK) Formula:**
This is the color difference formula to use when comparing process colors (c,m,y,k). Colors are compared in the *Overview Ink Solids* tab, in the *Automatic Measurement dialog*, and in *reports*.

The following color difference formulas are supported: CIELAB Delta E (Classic), Delta E 94, Delta E 2000, CMC (1:1), CMC(2:1).

Selection of the right formula depends on the printing process control standard used in your environment. Most ISO printing standards specify color difference tolerances based on the Classic ΔE formula for process colors, and on the Delta E 2000 formula for spot colors.

**ΔE (CMYK) Tolerance:**
This is the maximum color difference allowed between measured and desired process colors. This value is used in the *Overview Ink Solids* tab and in *reports*. When the color difference between the measured ink solid and the desired ink solid exceeds the ΔE (CMYK) tolerance value, the values in these panels are marked in red.

**ΔE (SPOT) Formula:**
This is the color difference formula to use when comparing spot colors, i.e. any non-cmyk colors. The same formulas as ΔE (CMYK) are supported.

**ΔE (SPOT) Tolerance:**
This is the maximum color difference allowed between measured and desired spot colors. It works similarly to the ΔE (CMYK) Tolerance.

**Density Filter:**
This is the density filter or ‘response’ used by densitometers, determining the reflected light captured over a specific range of wavelengths. It is important to select the density filter that is used by your measurement device. The following Table provides a quick reference.
### Filter Application Notes ISO Equivalent

<table>
<thead>
<tr>
<th>Filter</th>
<th>Application Notes</th>
<th>ISO Equivalent</th>
<th>Language</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANSI A</td>
<td>Wide-band color reflection and transmission response; used mainly in the photographic industry for measuring prints and slides</td>
<td>ISO STATUS A</td>
<td>English</td>
</tr>
<tr>
<td>ANSI T</td>
<td>Wide-band color reflection response; used mainly in the US</td>
<td>ISO STATUS T</td>
<td>English</td>
</tr>
<tr>
<td>DIN</td>
<td>Wide-band color reflection response; used mainly in Europe; produces higher values for yellow than ANSI T / ISO STATUS T</td>
<td>ISO STATUS E</td>
<td>English</td>
</tr>
<tr>
<td>DIN NB</td>
<td>Narrow-band densitometer response; rarely used</td>
<td>ISO STATUS I</td>
<td>English</td>
</tr>
<tr>
<td>ISO STATUS A</td>
<td>ISO version of ANSI A</td>
<td>ISO STATUS A</td>
<td>English</td>
</tr>
<tr>
<td>ISO STATUS M</td>
<td>Wide-band color transmission response; used mainly in the photographic industry for measuring negatives</td>
<td>ISO STATUS M</td>
<td>English</td>
</tr>
<tr>
<td>ISO STATUS T</td>
<td>ISO version of ANSI T</td>
<td>ISO STATUS T</td>
<td>English</td>
</tr>
<tr>
<td>ISO STATUS E</td>
<td>ISO version of DIN</td>
<td>ISO STATUS E</td>
<td>English</td>
</tr>
<tr>
<td>ISO STATUS I</td>
<td>Narrow-band densitometer response; rarely used</td>
<td>ISO STATUS I</td>
<td>English</td>
</tr>
</tbody>
</table>

**Density Paper:**

Choose if the density values displayed in the Overview Ink Solids tab, in the Automatic Measurement dialog, and in reports should be relative to the paper or not.

**Decimal Separator:**

Select the desired decimal separator (point/dot or comma) when importing/exporting numerical values in plain text files.

### 10.4 Curve Fitting Options

You can influence the way a PressSync curve is matched to a calculated dgc curve (calculated compensation points). Select either Robust or Standard under the Curve fit drop-down selection box on the Curve Pilot curve editing window.

You can decide on the most suitable fitting method based on the number of data points in your measured data sets. The following Table can be used as a guideline.

<table>
<thead>
<tr>
<th>You measure...</th>
<th>Other factors</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control strips containing a limited number of patches</td>
<td>NA</td>
<td>Standard</td>
</tr>
<tr>
<td>Profiles or control strips containing a large number of patches</td>
<td>Measured data are relatively smooth; printing conditions are stable and measurements reliable</td>
<td>Standard</td>
</tr>
<tr>
<td></td>
<td>Measured data are not smooth due to printing instabilities and/or measurement errors</td>
<td>Robust</td>
</tr>
</tbody>
</table>

For detailed information, see Robust Fit and Standard Fit below.
**Robust Fit**

A PressSync curve is selected so that the sum of absolute deviations between y values of the calculated compensation points and y values on the PressSync curve is minimal:

\[
\text{Mean Deviation (MD)} = \min \sum |Y_{\text{data}} - Y_{\text{curve}}|
\]

The result of this fit is that adjustment points following a normal trend relative to a PressSync curve will fit the curve very well, while other points that deviate from this trend will be left aside. The PressSync curve will tend to follow common points and ignore outliers.

With this method, multiple solutions are possible for some groups of points. This can result in unstable curve fitting.

**Standard Fit**

A PressSync curve is selected so that the sum of squared deviations between y values of the calculated compensation points and y values on the PressSync curve is minimal:

\[
\text{Standard Deviation (SD)} = \min \sum (Y_{\text{data}} - Y_{\text{curve}})^2
\]

The result of this fit is a curve that fits all data points equally well. The PressSync curve will tend to follow all points (equally weighted). Data points that do not follow the average behavior of other points will have a significant impact on the shape of the curve.

With this method, fitting may not be robust with respect to outliers. But there will be only one solution (optimal curve) for a given group of points, so fitting will be stable.

### 10.5 Print Chart Layouts

Predefined chart layouts are provided with Curve Pilot to support automated measuring of prints. When starting an *automated measurement*, these can be selected from the *Layout* drop-down selection list.

Chart layouts are text files with the `.it8` extension. The actual charts are `.pdf` files; some are provided with your Curve Pilot installation. See *Location of Data Files* on page 72 in Curve Pilot.

The following Table summarizes the chart layouts (.it8) currently supported by Curve Pilot in automated measurements mode. When `.pdf` files are available, this is clearly indicated in the Table. A separate section discusses *Control Strips for Equinox* on page 77.

<table>
<thead>
<tr>
<th>Chart Layout</th>
<th>PDF Available</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>ECI_GrayConL_v2.it8</td>
<td>No</td>
<td><a href="http://www.eci.org">www.eci.org</a></td>
</tr>
<tr>
<td>ECI_GrayConM_v2.it8</td>
<td>No</td>
<td><a href="http://www.eci.org">www.eci.org</a></td>
</tr>
<tr>
<td>ECI_MediaWedge_v30.it8</td>
<td>No</td>
<td><a href="http://www.fogra.org">www.fogra.org</a></td>
</tr>
<tr>
<td>ECI_MediaWedge_v30a.it8</td>
<td>No</td>
<td><a href="http://www.fogra.org">www.fogra.org</a></td>
</tr>
<tr>
<td>ECI_MediaWedge_v30b.it8</td>
<td>No</td>
<td><a href="http://www.fogra.org">www.fogra.org</a></td>
</tr>
<tr>
<td>IDEAlliance ISO 12647-7_Control Strip 2009.it8</td>
<td>Yes</td>
<td><a href="http://www.idealliance.org">www.idealliance.org</a></td>
</tr>
<tr>
<td>IDEAlliance ISO 12647-7_Control Strip 2013.it8</td>
<td>Yes</td>
<td><a href="http://www.idealliance.org">www.idealliance.org</a></td>
</tr>
<tr>
<td>IT874_cmyk_Visual.it8</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>IT874_cmyk_Random.it8</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>
The selection entry From Layout generates a chart layout from the settings used in the curve set Setup dialog of the application. This layout takes into account the number of patches for process colors set in the Process Colors tab, the number of patches for cmy-composed gray set in the Gray Balance tab, and the number of patches for spot colors set in the Spot Colors tab.

### 10.5.1 The Universal Target

The Universal Target is available as .pdf file. You can use it to manually measure process colors (c,m,y,k) and cmy-composed gray.

<table>
<thead>
<tr>
<th>Universal Target</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Universal14cTarget.v2.1.pdf</td>
<td>See Location of Data Files on page 72</td>
</tr>
</tbody>
</table>

The Universal Target provided with your Curve Pilot installation contains vignettes for the process colors (c,m,y,k), a cmy-composed gray vignette, and two gray square areas composed of a fixed cyan percentage with varying magenta and yellow compositions. These two gray squares (dark and light) are used in estimating gray balance.
**Note:** The Universal Target provided with your Curve Pilot installation does not include vignettes of spot colors for Equinox (o,g,b,...). If you need to measure spot colors for Equinox or any other special inks, perform automated measurements using the appropriate chart layout.

### 10.6 Control Strips for Equinox

The following Table summarizes the control strips provided with Curve Pilot to support Equinox printing conditions. When starting an automated measurement, these control strip layouts can be selected from the Layout drop-down box.

<table>
<thead>
<tr>
<th>Strip</th>
<th>Layout</th>
<th>PDF</th>
<th>Type</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>ESKU_CMYK_Gray_Control_Strip_i1iO_1row_Sep_value.it8</td>
<td>ESKU_CMYK_Gray_Control_Strip_i1iO_1row_Sep_value.pdf</td>
<td>Single-row (suitable for the i1iO measuring device)</td>
<td>Contains patches for C, M, Y, K tones and ink solids, G7 composed CMY gray and CMY solid, Red (M+Y), Green (C+Y), Blue (C+M)</td>
</tr>
<tr>
<td></td>
<td>ESKU_CMYK_Gray_Control_Strip_i1_1row_Sep_value.it8</td>
<td>ESKU_CMYK_Gray_Control_Strip_i1_1row_Sep_value.pdf</td>
<td>Single-row (suitable for the i1 measuring device)</td>
<td>Contains patches for C, M, Y, K tones and ink solids, G7 composed CMY gray and CMY solid</td>
</tr>
<tr>
<td></td>
<td>ESKU_CMYK_Gray_Control_Strip_i1_2rows_Sep_value.it8</td>
<td>ESKU_CMYK_Gray_Control_Strip_i1_2rows_Sep_value.pdf</td>
<td>Double-row (suitable for the i1iO and i1 measuring devices)</td>
<td>Contains the same patches as ESKU_CMYK_Gray_Control_Strip_i1iO_1row_Sep_value.it8 spread over two rows</td>
</tr>
<tr>
<td></td>
<td>ESKU_Single_Ink_Control_Strip_Sep.it8</td>
<td>ESKU_Single_Ink_Control_Strip_Orange_Sep_value.pdf</td>
<td>Single-row, single-ink</td>
<td>Contains different tints and the solid patch for one ink.</td>
</tr>
</tbody>
</table>

**Note:** There are PDF files available for orange, green, and blue, but the control strip can also be used to print other inks. Curve Pilot will detect the ink automatically from the ink solid patch on the strip. However, this ink must be one of the inks available in the ClassicColors CMS ink book.
This strip can be measured in combination with Esko cmyk strips, to derive curves for process colors and one or more Equinox colors (o,g,b,v,...)

<table>
<thead>
<tr>
<th>Strip</th>
<th>0</th>
<th>10</th>
<th>25</th>
<th>50</th>
<th>75</th>
<th>90</th>
<th>100</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Layout</th>
<th>ESKO_Spot_Control_Strip_Sep.it8</th>
</tr>
</thead>
<tbody>
<tr>
<td>PDF</td>
<td>ESKO_Spot_Control_Strip_Sep_value.pdf</td>
</tr>
<tr>
<td>Type</td>
<td>Single-row, single-ink</td>
</tr>
<tr>
<td>Comments</td>
<td>Contains different tints and the solid patch for one spot color ink.</td>
</tr>
</tbody>
</table>

**Note:** The layout file is a sample for Pantone 7452C. You should make separate layout files for each spot color that is going to be measured following the procedure in *New Control Strips for Spot Colors* on page 78.

### 10.6.1 New Control Strips for Spot Colors

To create a new control strip layout for a spot color and add it to Curve Pilot:

1. Open the Curve Pilot data folder, i.e. c:\Esko\bg_data_intellicurve_v160.
2. Make a copy of the ESKO_Spot_Control_Strip_Sep.it8 layout file.
3. Make sure that the spot color code is reflected in the file name, e.g. name the file ESKO_Spot_Control_Strip_P7462C.it8 if you are creating a layout file for Pantone 7462C.
4. Edit this file with a standard text editor, and change the value of the PROCESSCOLOR_ID field, which defines the spot color. For Pantone 7462C, the PROCESSCOLOR_ID line should read:

   ```
   PROCESSCOLOR_ID "pms1000c/7462"
   ```

   where pms1000c is the inkbook name.
5. Save the file, and use it with Curve Pilot. You will need to close and reopen the **Automatic Measurement** dialog so that the **Layout** drop-down selection list is updated.

### 10.7 Supported Spectrophotometers in Automated Measurements

The following spectrophotometers are supported by Curve Pilot / PressSync Pilot in automated measurements mode:

<table>
<thead>
<tr>
<th>Vendor</th>
<th>Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>X-Rite</td>
<td>i1</td>
</tr>
<tr>
<td>X-Rite</td>
<td>i110</td>
</tr>
</tbody>
</table>
10.8 The .it8 (CGATS) File Format

The .it8 (CGATS) file format is text-based. Curve Pilot can use the .it8 file format to save/export and import measured data.

Imported .it8 data files may contain LAB, XYZ, and/or spectral data. Multi-channel data files or files that contain spot colors are also supported.

When non-cmyk inks are used, the inks must be specified as extra fields in the file. These inks must be known to the CMS, and each ink must be defined in the file in a separate line. The required syntax is:

PROCESSCOLOR_ID "inkbook/inkname"

The data file shown below comes from an automatic measurement system that measured 5 inks: the process inks c,m,y,k and the Pantone 722 Coated.

ORIGINATOR Cartonnages - AutoMeasurementFromPress
FILE_DESCRIPTOR Jobname: OF23408, SheetNumber: 1, Press Name: R706
CREATED 13-Jan-2012 11:36:16
TARGET_TYPE ANSI IT8.7/4
COPYRIGHT NA
PRINT_CONDITIONS See ANSI CGATS/GRACoL TR 006-2007
ILLUMINANT D50
MEASUREMENT_GEOMETRY 0/45
OBSERVER CIE 2 degree
SAMPLE_BACKING White
PROCESSCOLOR_ID Cyan
PROCESSCOLOR_ID Magenta
PROCESSCOLOR_ID Yellow
PROCESSCOLOR_ID Black
PROCESSCOLOR_ID "PMS1000C/722"
NUMBER_OF_FIELDS 40
BEGIN_DATA_FORMAT
SAMPLE_ID PC5_1 PC5_2 PC5_3 PC5_4 PC5_5 LAB_L LAB_A LAB_B
NM_400 ...
END_DATA_FORMAT
NUMBER_OF_SETS 224
BEGIN_DATA
1 0 0 0 0 0 0 10 0 17.67 1.87 0.13 1.78 2.73 1.84 2.48
2 100 0 0 0 0 0 57.79 -33.52 -45.33 33.58 43.77 51.84 57.92
3 0 100 0 0 0 0 50.11 68.93 -6.62 20.81 22.64 24.23 26.27
4 0 0 100 0 0 0 85.62 -2.7 100.91 2.37 2.43 1.66 2.09
5 0 0 0 0 100 77.54 13.79 24.3 32.92 32.83 33.89 33.3
6 0 75 0 0 0 0 58.13 56.66 -10.33 30.17 31.77 35.12 37.29
7 0 0 75 0 0 0 87.12 -6.06 74.24 12.84 10.79 9.39 9.11
8 0 0 0 0 25 85.55 4.94 6.98 51.66 55.72 61.14 63.33
9 0 0 0 100 0 0 16.39 1.32 0.25 0.95 1.76 2.16 2.26

The Pantone color is defined last with PROCESSCOLOR_ID "PMS1000C/722", and its composition in the patches (%) is shown in the 5th column (PC5_5) of the measured data.

To calculate dot gain compensation curves for all inks in the data file, there must be enough patches composed from single inks, and a solid (100%) patch for each ink defined in the .it8 file.
Similarly, if you want to base dot gain compensation on gray balance, there must be enough gray patches in the file. These gray patches need to have neutral cmy compositions as defined in the Neutral Gray CMY Triplet Table by G7. Only patches that are close to neutral gray compositions (+/- 1%) will be extracted from the .it8 file.

10.8.1 Control Strip Layouts and .it8 (CGATS) Files

To use an .it8 strip layout with Curve Pilot, some extra data must be defined in the file:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Example Value</th>
<th>Unit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CGATSKKEY_LAYOUT_TYPE</td>
<td>Esko</td>
<td></td>
<td>Number of rows to measure</td>
</tr>
<tr>
<td>NUMBER_OF_STRIPES</td>
<td>12</td>
<td></td>
<td>Number of columns to measure</td>
</tr>
<tr>
<td>NUMBER_OF_COLS</td>
<td>25</td>
<td></td>
<td>Width of a patch, including border and gaps</td>
</tr>
<tr>
<td>PATCH_WIDTH</td>
<td>9 mm</td>
<td></td>
<td>Height of a patch, including border and gaps</td>
</tr>
<tr>
<td>PATCH_HEIGHT</td>
<td>8 mm</td>
<td></td>
<td>Gap between patches in a row</td>
</tr>
<tr>
<td>GAP_SIZE_X</td>
<td>1 mm</td>
<td></td>
<td>Gap between patches in a column</td>
</tr>
<tr>
<td>MIRROR_X</td>
<td>1 mm</td>
<td></td>
<td>Indicates if columns need to be mirrored</td>
</tr>
<tr>
<td>BORDER_PATCHES</td>
<td>0 mm</td>
<td></td>
<td>Border around patches</td>
</tr>
</tbody>
</table>

Each patch must have a proper c,m,y,k composition, and the order of patches listed in the .it8 file must be the same as the order of patches on the chart, starting from the first row and continuing for each column in a left-to-right direction.

You can learn more about the .it8 format by examining one of the control strip layouts provided with your Curve Pilot installation. See Location of Data Files on page 72 in Curve Pilot.

10.9 Tone Curve Exchange Data (TED) Files

A .ted file is an xml file based on international standards (ISO 18620) for the exchange of tone curve data between software applications.

A .ted file can contain any number of tone curves corresponding to any number of inks/separations. Tone curves are also known as ‘transfer’ curves or ‘plate’ curves.

The key xml element within a .ted file is TransferCurve and its key attribute (property) is Separation. Data are specified as x, y pairs in the [0-1] range.

The rules for converting .ted files into .icpro strategies are simple:

1. A TransferCurve element with Separation="Cyan|Magenta|Yellow|Black" is converted into a Curve Pilot dot gain compensation (dgc) curve for the separation value (Cyan, Magenta, Yellow, or Black).
2. A TransferCurve element with Separation="All" is converted into a Curve Pilot dgc curve for Other Inks.
3. A `TransferCurve` element with `Separation="<InkName>"` is converted into a Curve Pilot dgc curve for the `<InkName>` ink in the Designer inkbook.

Below is a sample `.ted` data file for reference.

```xml
<?xml version="1.0" encoding="UTF-8"?>
<TransferCurveSet xmlns="http://www.npes.org/schema/ISO18620/"
Creator="My Press Calibration Software"
CreationDate="2013-04-09T17:08:30-05:00"
OperatorName="Samuel Adams"
PressName="My Printing Press"
MediaName="Standard Coated paper"
Side="Front"
MeasurementFile="d:\tmp\data.txt"
TransferCurveSetID="CRD-24-3">
<FormPreparationDetails Description="Euclidean screen"/>
<PrintingCondition PrintingConditionID="Fogra39"/>
<TransferCurve Separation="Cyan" TransferCurveID="C_0100"
PrintingUnitNumber="1"
Curve="0.0 0.0 0.5 0.4 1.0 1.0" />
<TransferCurve Separation="Black" TransferCurveID="K_0100"
PrintingUnitNumber="2"
Curve="0.0 0.0 1.0 1.0" />
<TransferCurve Separation="KitKat Red" TransferCurveID="KKR_0100"
Curve="0.0 0.0 0.1 0.2 0.5 0.6 0.8 0.9 1.0 1.0" />
<TransferCurve Separation="All" TransferCurveID="All_0100"
Curve="0.0 0.0 0.1 0.15 0.5 0.65 0.8 0.95 1.0 1.0" />
</TransferCurveSet>
```

10.10 PressSync Templates Based on the ISO 12647 Standards

Curve Pilot provides a number of `.prsync` templates based on desired printing conditions (profiles) derived from the ISO 12647-2 or ISO 12647-3 standards. Within this family of `.prsync` templates, desired Lab values for c,m,y,k patches, paper, and solids are calculated using Fogra characterization data for standardized printing conditions.

<table>
<thead>
<tr>
<th>PressSync Template</th>
<th>cmyk_Equinox</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>Offset Lithography</td>
</tr>
<tr>
<td>Paper Type</td>
<td>ISO 12647-2 Types 1&amp;2: high weight coated (HWC) matte, semi-matte, or glossy; typical density 80-250 g/m2</td>
</tr>
<tr>
<td>Desired Printing Condition</td>
<td>ISOCoated_v2_300_eci.icc</td>
</tr>
<tr>
<td>Target DGC curves</td>
<td>FOGRA A (CMY) and B (K) as defined in ISO 12647-2:2004</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PressSync Template</th>
<th>cmyk_ISO_Newspaper</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>Heatset Web Offset Printing</td>
</tr>
<tr>
<td>Paper Type</td>
<td>Standard News Print (SNP): standard newspaper; typical density 40-52 g/m2</td>
</tr>
<tr>
<td>Desired Printing Condition</td>
<td>PSO_SNAPSHOT_paper_eci.icc</td>
</tr>
<tr>
<td>PressSync Template</td>
<td>cmyk_ISO_Newsprint</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Target DGC curves</td>
<td>FOGRA C (CMY) and D (K) as defined in ISO 12647-2:2004</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PressSync Template</th>
<th>cmyk_ISO_PT1&amp;2 (NP)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>Offset Lithographic Processes</td>
</tr>
<tr>
<td>Paper Type</td>
<td>ISO 12647-2 Types 1&amp;2: high weight coated (HWC) matte, semi-matte, or glossy; typical density 80-250 g/m2</td>
</tr>
<tr>
<td>Desired Printing Condition</td>
<td>ISOcoated_v2_300_eci.icc</td>
</tr>
<tr>
<td>Target DGC curves</td>
<td>FOGRA F (CMYK) as defined in ISO 12647-2:2004</td>
</tr>
<tr>
<td>Notes</td>
<td>For typical stochastic (non-periodic/NP) screening</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PressSync Template</th>
<th>cmyk_ISO_PT1&amp;2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>Offset Lithographic Processes</td>
</tr>
<tr>
<td>Paper Type</td>
<td>ISO 12647-2 Types 1&amp;2: high weight coated (HWC) matte, semi-matte, or glossy; typical density 80-250 g/m2</td>
</tr>
<tr>
<td>Desired Printing Condition</td>
<td>ISOcoated_v2_300_eci.icc</td>
</tr>
<tr>
<td>Target DGC curves</td>
<td>FOGRA A (CMY) and B (K) as defined in ISO 12647-2:2004</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PressSync Template</th>
<th>cmyk_ISO_PT3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>Offset Lithographic Processes, Web</td>
</tr>
<tr>
<td>Paper Type</td>
<td>ISO 12647-2 Type 3: standard light weight coated (LWC) paper; typical density 48-80 g/m2</td>
</tr>
<tr>
<td>Desired Printing Condition</td>
<td>PSO_LWC_Standard_eci.icc</td>
</tr>
<tr>
<td>Target DGC curves</td>
<td>FOGRA B (CMY) and C (K) as defined in ISO 12647-2:2004</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PressSync Template</th>
<th>cmyk_ISO_PT4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>Offset Lithographic Processes, Web</td>
</tr>
<tr>
<td>Paper Type</td>
<td>ISO 12647-2 Type 4: wood free uncoated white paper; typical density 80-250 g/m2</td>
</tr>
<tr>
<td>Desired Printing Condition</td>
<td>PSO_Uncoated_ISO12647_eci.icc</td>
</tr>
<tr>
<td>Target DGC curves</td>
<td>FOGRA C (CMY) and D (K) as defined in ISO 12647-2:2004</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PressSync Template</th>
<th>cmyk_ISO_PT5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>Offset Lithographic Processes, Web</td>
</tr>
<tr>
<td>Paper Type</td>
<td>ISO 12647-2 Type 5: uncoated yellowish recycled paper; typical density 110-120 g/m2</td>
</tr>
<tr>
<td>Desired Printing Condition</td>
<td>ISOUncoatedyellowish.icc</td>
</tr>
<tr>
<td>Target DGC curves</td>
<td>FOGRA C (CMY) and D (K) as defined in ISO 12647-2:2004</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PressSync Template</th>
<th>cmyk_ISO_WEB</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>Offset Lithographic Processes, Web</td>
</tr>
<tr>
<td>Paper Type</td>
<td>Super calendered (SC) offset paper for web; typical density 38-60 g/m2</td>
</tr>
</tbody>
</table>
### Curve Pilot

#### 10.11 PressSync Templates Based on the G7 Calibration Method

Curve Pilot provides a number of .prsync templates based on desired printing conditions derived from industrial specifications such as **GRACoL**, **SNAP**, and **SWOP**. Within this family of .prsync templates, desired Lab values for gray patches, paper, and solid are gray-balanced and calculated using the G7 calibration methodology.

<table>
<thead>
<tr>
<th>PressSync Template</th>
<th>cmyk_ISO_WEB</th>
</tr>
</thead>
<tbody>
<tr>
<td>Desired Printing Condition</td>
<td>ISOwebcoated.icc</td>
</tr>
<tr>
<td>Target DGC curves</td>
<td>FOGRA B (CMY) and C (K) as defined in ISO 12647-2:2004</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PressSync Template</th>
<th>3ck_Equinox</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>Commercial Offset Lithography</td>
</tr>
<tr>
<td>Paper Type</td>
<td>ISO 12647-2 Types 1&amp;2: high weight coated (HWC) matte, semi-matte, or glossy; density 80-250 g/m2</td>
</tr>
<tr>
<td>Desired Printing Condition</td>
<td>GRACol2006_Coated1v2.icc</td>
</tr>
<tr>
<td>Target DGC curves</td>
<td>GRACol G7 (3C+K)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PressSync Template</th>
<th>3ck_GRAColG7</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>Commercial Offset Lithography</td>
</tr>
<tr>
<td>Paper Type</td>
<td>ISO 12647-2 Types 1&amp;2: high weight coated (HWC) matte, semi-matte, or glossy; density 80-250 g/m2</td>
</tr>
<tr>
<td>Desired Printing Condition</td>
<td>GRACol2006_Coated1v2.icc</td>
</tr>
<tr>
<td>Target DGC curves</td>
<td>GRACol G7 (3C+K)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PressSync Template</th>
<th>3ck_SNAP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>Newsprint &amp; Advertising</td>
</tr>
<tr>
<td>Paper Type</td>
<td>As per ISO 12647-3:2005 (newsprint paper)</td>
</tr>
<tr>
<td>Desired Printing Condition</td>
<td>SNAP2007.icc</td>
</tr>
<tr>
<td>Target DGC curves</td>
<td>GRACol G7 (3C+K)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PressSync Template</th>
<th>3ck_SWOP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>Web Offset Publications</td>
</tr>
<tr>
<td>Paper Type</td>
<td>ISO 12647-2 Type 3: light weight coated (LWC) paper, web</td>
</tr>
<tr>
<td>Desired Printing Condition</td>
<td>SWOP2006_coated3_GCR_bas.icc</td>
</tr>
<tr>
<td>Target DGC curves</td>
<td>GRACol G7 (3C+K)</td>
</tr>
</tbody>
</table>
10.12 User Defined Dot Gain Curves for Process Colors

To generate a User Defined dot gain curve for a process color:

1. Go to the Process Colors tab of the Setup dialog.
2. If the Desired <Value> on Universal Target panel is collapsed, click on ▶ to expand it.

**Note:** <Value> will be one of density, %DotArea, ΔE-P, or %ΔE-SP, depending upon the setting in the Measure drop-down selection list.

3. If you are working with a cmyk_ template, enter the desired values for Cyan, Magenta, Yellow, or Black for the ¼ (25%), ½ (50%), and ¾ (75%) patches.
   If you are working with a 3ck_ template, enter the desired values for CMY (3c gray) or Black for the ¼ (25%), ½ (50%), and ¾ (75%) patches.
4. If the Desired <Value> on a Control Strip panel is collapsed, click on ▶ to expand it.
5. Edit the number of Patches present in the control strip layout. This number refers to intermediate patches only (excluding paper and solid). The default number of intermediate patches is 3.
6. If you want to customize the intermediate patch compositions, enter the desired Tones under Patch 1, ..., Patch n, where n is the number of intermediate Patches set above.
7. If you are working with a cmyk_ template, enter the desired values for Cyan, Magenta, Yellow, or Black for Patch 1, ..., Patch n.
   If you are working with a 3ck_ template, enter the desired values for CMY (3c gray) or Black for Patch 1, ..., Patch n.

**Note:** Curve Pilot will calculate the best fitting desired dot gain curve from both data sets, i.e. the values entered for the Universal Target and the values entered for the Control Strip.

10.13 User Defined Dot Gain Curves for Spot Colors

To generate a User Defined dot gain curve for a spot color:

1. Go to the Spot Colors tab of the Setup dialog.
2. If the Desired <Value> on Universal Target panel is collapsed, click on ▶ to expand it.

**Note:** <Value> can be one of density, %DotArea, ΔE-P, or %ΔE-SP, depending upon the setting in the Measure drop-down selection list.

3. Select a spot color under the Spot Colors list.
4. Enter the desired values for the ¼ (25%), ½ (50%), and ¾ (75%) patches.
5. If the Desired <Value> on a Control Strip panel is collapsed, click on ▶ to expand it.
6. Edit the number of Patches present in the control strip layout. This number refers to intermediate patches only (excluding paper and solid). The default number of intermediate patches is 3.
7. If you want to customize the intermediate patch compositions, enter the desired Tones under Patch 1, ..., Patch n, where n is the number of intermediate Patches set above.
8. Enter the desired values for Patch 1, ..., Patch n.
Note: Curve Pilot will calculate the best fitting desired dot gain curve from both data sets, i.e. the values entered for the Universal Target and the values entered for the Control Strip.

10.14 Migration Tool for SCRDGC Files

The screen-based dgc strategy format (.scrdgc) has been replaced by the .icpro dgc strategy format. The selection and use of existing .scrdgc files in all Esko workflows is still supported, but you have to migrate them to .icpro if you want to edit them.

To migrate individual .scrdgc files, select File > Import > SCRDGC on the Curve Pilot main menu.

Importing screen-based strategies one by one can be time-consuming. The Migration Tool enables you to automatically upgrade all existing screen-based strategy files in the central location of dgc data to the .icpro strategy format in one go.

Your original .scrdgc files are first automatically backed up to a subfolder of the dgc data folder. Following conversion, the original .scrdgc files can be deleted from their original location. If you choose to do so, do not forget to update all references in your tickets and FlexRip configurations from the old .scrdgc files to the new .icpro ones. Your RIP output is guaranteed to remain the same.

Note: Screen-based dgc files created by Color Engine Pilot for proofing or factory screen-based strategies for proofing will not be touched or upgraded by this tool.

To migrate your .scrdgc files follow the procedure below. The instructions assume that your Curve Pilot application is installed locally under c:\Esko, and that dgc data are located centrally under \server\bg_data_dgc_v010.

1. Run c:\Esko\bg_prog_intellicurve_v160\bin_ix86\migratescrdgc.exe.

   The following MS Dos window appears:
2. Follow the instructions on the screen for each step: type y for yes and n for no.
3. When you check the `\server\bg_data_dgc_v010\scrdgcBackup` folder, you can see that the old .scrdgc files are backed up in that folder.

### 10.15 Neutral Gray CMY Triplet Table

<table>
<thead>
<tr>
<th>Gray (%)</th>
<th>C (%)</th>
<th>M (%)</th>
<th>Y (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>1.96</td>
<td>1.96</td>
<td>1.18</td>
<td>1.18</td>
</tr>
<tr>
<td>3.92</td>
<td>3.92</td>
<td>2.75</td>
<td>2.75</td>
</tr>
<tr>
<td>5.88</td>
<td>5.88</td>
<td>4.31</td>
<td>4.31</td>
</tr>
<tr>
<td>7.84</td>
<td>7.84</td>
<td>5.49</td>
<td>5.49</td>
</tr>
<tr>
<td>10.20</td>
<td>10.20</td>
<td>7.45</td>
<td>7.45</td>
</tr>
<tr>
<td>20.00</td>
<td>20.00</td>
<td>14.90</td>
<td>14.90</td>
</tr>
<tr>
<td>25.10</td>
<td>25.10</td>
<td>18.82</td>
<td>18.82</td>
</tr>
<tr>
<td>30.20</td>
<td>30.20</td>
<td>23.14</td>
<td>23.14</td>
</tr>
<tr>
<td>34.90</td>
<td>34.90</td>
<td>27.06</td>
<td>27.06</td>
</tr>
<tr>
<td>40.00</td>
<td>40.00</td>
<td>31.37</td>
<td>31.37</td>
</tr>
<tr>
<td>45.10</td>
<td>45.10</td>
<td>35.69</td>
<td>35.69</td>
</tr>
<tr>
<td>49.80</td>
<td>49.80</td>
<td>40.00</td>
<td>40.00</td>
</tr>
<tr>
<td>54.90</td>
<td>54.90</td>
<td>45.10</td>
<td>45.10</td>
</tr>
<tr>
<td>60.00</td>
<td>60.00</td>
<td>50.20</td>
<td>50.20</td>
</tr>
<tr>
<td>65.10</td>
<td>65.10</td>
<td>55.29</td>
<td>55.29</td>
</tr>
<tr>
<td>69.80</td>
<td>69.80</td>
<td>60.39</td>
<td>60.39</td>
</tr>
<tr>
<td>74.90</td>
<td>74.90</td>
<td>65.88</td>
<td>65.88</td>
</tr>
<tr>
<td>80.00</td>
<td>80.00</td>
<td>71.76</td>
<td>71.76</td>
</tr>
<tr>
<td>85.10</td>
<td>85.10</td>
<td>78.04</td>
<td>78.04</td>
</tr>
<tr>
<td>89.80</td>
<td>89.80</td>
<td>84.31</td>
<td>84.31</td>
</tr>
<tr>
<td>94.90</td>
<td>94.90</td>
<td>92.16</td>
<td>92.16</td>
</tr>
<tr>
<td>98.04</td>
<td>98.04</td>
<td>96.86</td>
<td>96.86</td>
</tr>
<tr>
<td>100.00</td>
<td>100.00</td>
<td>100.00</td>
<td>100.00</td>
</tr>
</tbody>
</table>
11. Glossary

BLACK MASK
When making flexo plates with an Esko CDI, a black mask will come out of the machine. This is the non-processed black flexo plate which has not been washed out yet.

CGATS
CGATS is the Committee for Graphic Arts Technologies Standards.

CONTINUOUS TONE IMAGE (CT)
A continuous tone image (also called a contone image) is an unscreened image which is composed by pixels containing 256 possible gradient tones, varying from white (0) to black (256). The most common example is a photograph.

CONVENTIONAL SCREEN
A conventional screen, also called AM (amplitude modulated) or traditional screen, is a screen where the dots are placed on a fixed grid and where the dot sizes vary according to tonal differences: bigger dots simulate darker tonal values, while smaller dots simulate lighter tonal values.
The Esko variant of conventional screening is called Classic screening.

DOT GAIN (DG)
Dot gain is a phenomenon in printing where halftone dots are printed fatter than desired and/or expected. By applying a method of dot gain compensation, this phenomenon can be controlled.

DOT GAIN COMPENSATION (DGC)
Dot gain compensation is a technique that consists of reducing halftone dots on the film, in order to compensate the expected dot sizes on the print.

DGC STRATEGY
A DGC Strategy is a combination of various single Dot Gain Compensation Curves, which are applied accordingly to parts with different screens in a job. DGC Strategies replace the former Screen Based DGC curves.

DPI
DPI stands for dots per inch and refers to the output resolution of a printer or an image setter. However, DPI does not refer to the resolution of a halftone image, which is referred to as LPI.

FILM – DIGITAL FILM
The difference between a film and a digital film is the fact that a film refers to the physical film created by a film setter, while a digital film refers to a bitmap file created by a RIP, e.g. a screened Tiff file provided by FlexRipT4.

FLEXO PRINTING
Flexo printing or flexography is a rotary printing process that uses flexible photopolymer plates which contain a raised image (relief). The inked plates are rotated on a cylinder, in order to transfer the image to a substrate.

In flexo printing, fast-drying inks are used, so the process is ideal for printing on foils and plastics. Flexo is mainly used in the packaging market.

FOGRA

Fogra (full name Fogra Forschungsgesellschaft Druck e.V.) is a German-based graphic industry research association.

GRACoL®

GRACoL® (General Requirements for Applications in Commercial Offset Lithography) is a set of guidelines and recommendations to streamline the workflows between print buyers and print service suppliers.

GRAVURE PRINTING

Gravure printing (also rotogravure printing) is a rotary printing process whereby an image is engraved in a copper cylinder. The engraving of the image on the plate is done by a laser etching or a diamond tipped machine, which etches millions of small cells in the cylinder.

HALFTONE IMAGE

A halftone image is the printed simulation of a contone (continuous tone) image, using black or white dots, that can vary in size, to simulate the continuous tone image in the print. See also: screening.

ICC

ICC is the International Color Consortium.

LPI

LPI or Lines per inch is the resolution of a halftone print. The higher the LPI, the sharper the print. LPI is also referred to as the screen ruling.

OFFSET PRINTING

Offset printing is a printing technique that uses the principle of the lithographic process: the cylinder which carries the image contains two parts: one part that repulses water and attracts oil (the image part), and a part that repulses oil and attracts water (the non-printing part).

PIXEL

A pixel (or picture element) is the smallest component of an image reproduced on a screen, such as a TV screen or a computer screen. The combination of many pixels forms an image.

PLATE

A plate or printing plate is a plate which is provided by the plate setter and contains the positive or negative image that has to be transferred to the paper or other substrate. A plate can be made of metal (offset), rubber, polymer (flexo)...

To be ready to be put on a printing press, the plate needs to be processed or prepared by a chemical process. A processed plate is a plate that has been washed out and dried.

PPI
PPI stands for pixels per inch and refers to the resolution of a computer monitor, a scanner, a digital photo camera or a photograph.

SAMBAFLEX

SambaFlex by Esko is a hybrid (transitional) screening technology combining AM screening in the mid-tones and FM screening in the highlights and (optionally) in the shadows.

SCREENING

Screening is the process of converting a grayscale image into a pattern of small dots with a limited number of inks. Screening is sometimes called halftoning.

SNAP

SNAP (Specifications for Newsprint Advertising Production) is a set of specifications designed to improve reproduction quality in proofing and coldset printing by offset lithography on webs of newsprint grade paper (newspapers, pre-printed advertising inserts, etc.)

SWOP®

SWOP® (Specifications for Web Offset Publications) is a color reproduction specification for web offset lithography managed by IDEAlliance.

STOCHASTIC SCREEN

A stochastic or FM (frequency modulated) screen is a screen where the dots are placed randomly and not on a fixed grid. The number of dots varies according to the tonal differences: to simulate lighter tonal areas, less dots are placed, while more dots are placed to simulate darker tonal areas.

The Esko variant of stochastic screening is called Monet screening.

TRANSITION ZONE

Besides conventional and stochastic screens, there are also transitional screens, e.g. Esko's SambaFlex screens.

These are screens which have a stochastic part in highlights and shadows, and a conventional part in the midtones. In between is a transition zone, which contains a pattern that is gradually going from stochastic to conventional over a very big number of intermediate patterns.